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A.0 Disclaimer / Standard Warranty

CE certification

The equipment listed as CE certified means that the product complies with the essential requirements concerning safety and
hygiene. The European directives that have been taken into consideration in the design are available on written request to
ADB SAFEGATE.

ETL certification

The equipment listed as ETL certified means that the product complies with the essential requirements concerning safety and
C22.2 No.180:13 (R2018) regulations. The CSA directives that have been taken into consideration in the design are available
on written request to ADB SAFEGATE.

All Products Guarantee

ADB SAFEGATE will correct by repair or replacement per the applicable guarantee below, at its option, equipment or parts
which fail because of mechanical, electrical or physical defects, provided that the goods have been properly handled and
stored prior to installation, properly installed and properly operated after installation, and provided further that Buyer gives
ADB SAFEGATE written notice of such defects after delivery of the goods to Buyer. Refer to the Safety section for more
information on Material Handling Precautions and Storage precautions that must be followed.

ADB SAFEGATE reserves the right to examine goods upon which a claim is made. Said goods must be presented in the same
condition as when the defect therein was discovered. ADB SAFEGATE furthers reserves the right to require the return of such
goods to establish any claim.

ADB SAFEGATE's obligation under this guarantee is limited to making repair or replacement within a reasonable time after
receipt of such written notice and does not include any other costs such as the cost of removal of defective part, installation
of repaired product, labor or consequential damages of any kind, the exclusive remedy being to require such new parts to be
furnished.

ADB SAFEGATE's liability under no circumstances will exceed the contract price of goods claimed to be defective. Any returns
under this guarantee are to be on a transportation charges prepaid basis. For products not manufactured by, but sold by
ADB SAFEGATE, warranty is limited to that extended by the original manufacturer. This is ADB SAFEGATE's sole guarantee and
warranty with respect to the goods; there are no express warranties or warranties of fitness for any particular purpose or any
implied warranties of fitness for any particular purpose or any implied warranties other than those made expressly herein. All
such warranties being expressly disclaimed.

Standard Products Guarantee

Products manufactured by ADB SAFEGATE are guaranteed against mechanical, electrical, and physical defects (excluding
lamps) which may occur during proper and normal use for a period of two years from the date of ex-works delivery, and are
guaranteed to be merchantable and fit for the ordinary purposes for which such products are made.

Note
See your applicable sales agreement for a complete warranty description.
Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty
period is started for these replaced or repaired products.

FAA Certified products manufactured by ADB SAFEGATE

ADB SAFEGATE L858 Airfield Guidance Signs are warranted against mechanical and physical defects in design or manufacture
for a period of 2 years from date of installation, per FAA AC 150/5345-44 (applicable edition).

ADB SAFEGATE LED products (with the exception of obstruction lighting) are warranted against electrical defects in design or
manufacture of the LED or LED specific circuitry for a period of 4 years from date of installation, per FAA EB67 (applicable
edition). These FAA certified constant current (series) powered LED products must be installed, interfaced and powered with
and through products certified under the FAA Airfield Lighting Equipment Program (ALECP) to be included in this 4 (four) year
warranty. This includes, but is not limited to, interface with products such as Base Cans, Isolation Transformers, Connectors,
Wiring, and Constant Current Regulators.
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Note
See your sales order contract for a complete warranty description.
Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty
period is started for these replaced or repaired products.

Liability

WARNING
Use of the equipment in ways other than described in the catalog leaflet and the manual may result in personal injury,
death, or property and equipment damage. Use this equipment only as described in the manual.

ADB SAFEGATE cannot be held responsible for injuries or damages resulting from non-standard, unintended uses of its
equipment. The equipment is designed and intended only for the purpose described in the manual. Uses not described in the
manual are considered unintended uses and may result in serious personal injury, death or property damage.

Unintended uses, includes the following actions:

• Making changes to equipment that have not been recommended or described in this manual or using parts that are not
genuine ADB SAFEGATE replacement parts or accessories.

• Failing to make sure that auxiliary equipment complies with approval agency requirements, local codes, and all applicable
safety standards if not in contradiction with the general rules.

• Using materials or auxiliary equipment that are inappropriate or incompatible with your ADB SAFEGATE equipment.

• Allowing unskilled personnel to perform any task on or with the equipment.

Copyright Statement

This manual or parts thereof may not be reproduced, stored in a retrieval system, or transmitted, in any form or by any means,
electronic, mechanical, photocopying, recording, nor otherwise, without the author's prior written consent.

This manual could contain technical inaccuracies or typographical errors. The author reserves the right to revise this manual
from time to time in the contents thereof without obligation of the author to notify any person of such revision or change.
Details and values given in this manual are average values and have been compiled with care. They are not binding, however,
and the author disclaims any liability for damages or detriments suffered as a result of reliance on the information given
herein or the use of products, processes or equipment to which this manual refers. No warranty is made that the use of the
information or of the products, processes or equipment to which this manual refers will not infringe any third party's patents
or rights. The information given does not release the buyer from making their own experiments and tests.
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A.0 Safety

Introduction to Safety

This section contains general safety instructions for installing and using ADB SAFEGATE equipment. Some safety instructions
may not apply to the equipment in this manual. Task- and equipment-specific warnings are included in other sections of this
manual where appropriate.
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A.0 Disclaimer / Standard Warranty

CE certification

The equipment listed as CE certified means that the product complies with the essential requirements concerning safety and
hygiene. The European directives that have been taken into consideration in the design are available on written request to
ADB SAFEGATE.

ETL certification

The equipment listed as ETL certified means that the product complies with the essential requirements concerning safety and
C22.2 No.180:13 (R2018) regulations. The CSA directives that have been taken into consideration in the design are available
on written request to ADB SAFEGATE.

All Products Guarantee

ADB SAFEGATE will correct by repair or replacement per the applicable guarantee below, at its option, equipment or parts
which fail because of mechanical, electrical or physical defects, provided that the goods have been properly handled and
stored prior to installation, properly installed and properly operated after installation, and provided further that Buyer gives
ADB SAFEGATE written notice of such defects after delivery of the goods to Buyer. Refer to the Safety section for more
information on Material Handling Precautions and Storage precautions that must be followed.

ADB SAFEGATE reserves the right to examine goods upon which a claim is made. Said goods must be presented in the same
condition as when the defect therein was discovered. ADB SAFEGATE furthers reserves the right to require the return of such
goods to establish any claim.

ADB SAFEGATE's obligation under this guarantee is limited to making repair or replacement within a reasonable time after
receipt of such written notice and does not include any other costs such as the cost of removal of defective part, installation
of repaired product, labor or consequential damages of any kind, the exclusive remedy being to require such new parts to be
furnished.

ADB SAFEGATE's liability under no circumstances will exceed the contract price of goods claimed to be defective. Any returns
under this guarantee are to be on a transportation charges prepaid basis. For products not manufactured by, but sold by
ADB SAFEGATE, warranty is limited to that extended by the original manufacturer. This is ADB SAFEGATE's sole guarantee and
warranty with respect to the goods; there are no express warranties or warranties of fitness for any particular purpose or any
implied warranties of fitness for any particular purpose or any implied warranties other than those made expressly herein. All
such warranties being expressly disclaimed.

Standard Products Guarantee

Products manufactured by ADB SAFEGATE are guaranteed against mechanical, electrical, and physical defects (excluding
lamps) which may occur during proper and normal use for a period of two years from the date of ex-works delivery, and are
guaranteed to be merchantable and fit for the ordinary purposes for which such products are made.

Note
See your applicable sales agreement for a complete warranty description.
Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty
period is started for these replaced or repaired products.

FAA Certified products manufactured by ADB SAFEGATE

ADB SAFEGATE L858 Airfield Guidance Signs are warranted against mechanical and physical defects in design or manufacture
for a period of 2 years from date of installation, per FAA AC 150/5345-44 (applicable edition).

ADB SAFEGATE LED products (with the exception of obstruction lighting) are warranted against electrical defects in design or
manufacture of the LED or LED specific circuitry for a period of 4 years from date of installation, per FAA EB67 (applicable
edition). These FAA certified constant current (series) powered LED products must be installed, interfaced and powered with
and through products certified under the FAA Airfield Lighting Equipment Program (ALECP) to be included in this 4 (four) year
warranty. This includes, but is not limited to, interface with products such as Base Cans, Isolation Transformers, Connectors,
Wiring, and Constant Current Regulators.
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Note
See your sales order contract for a complete warranty description.
Replaced or repaired equipment under warranty falls into the warranty of the original delivery. No new warranty
period is started for these replaced or repaired products.

Liability

WARNING
Use of the equipment in ways other than described in the catalog leaflet and the manual may result in personal injury,
death, or property and equipment damage. Use this equipment only as described in the manual.

ADB SAFEGATE cannot be held responsible for injuries or damages resulting from non-standard, unintended uses of its
equipment. The equipment is designed and intended only for the purpose described in the manual. Uses not described in the
manual are considered unintended uses and may result in serious personal injury, death or property damage.

Unintended uses, includes the following actions:

• Making changes to equipment that have not been recommended or described in this manual or using parts that are not
genuine ADB SAFEGATE replacement parts or accessories.

• Failing to make sure that auxiliary equipment complies with approval agency requirements, local codes, and all applicable
safety standards if not in contradiction with the general rules.

• Using materials or auxiliary equipment that are inappropriate or incompatible with your ADB SAFEGATE equipment.

• Allowing unskilled personnel to perform any task on or with the equipment.

Copyright Statement

This manual or parts thereof may not be reproduced, stored in a retrieval system, or transmitted, in any form or by any means,
electronic, mechanical, photocopying, recording, nor otherwise, without the author's prior written consent.

This manual could contain technical inaccuracies or typographical errors. The author reserves the right to revise this manual
from time to time in the contents thereof without obligation of the author to notify any person of such revision or change.
Details and values given in this manual are average values and have been compiled with care. They are not binding, however,
and the author disclaims any liability for damages or detriments suffered as a result of reliance on the information given
herein or the use of products, processes or equipment to which this manual refers. No warranty is made that the use of the
information or of the products, processes or equipment to which this manual refers will not infringe any third party's patents
or rights. The information given does not release the buyer from making their own experiments and tests.

A.0 Safety Messages

HAZARD Icons used in the manual

For all HAZARD symbols in use, see the Safety section. All symbols must comply with ISO and ANSI standards.

Constant Current Regulator Type VIS
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Carefully read and observe all safety instructions in this manual, which alert you to safety hazards and conditions that may
result in personal injury, death or property and equipment damage and are accompanied by the symbol shown below.

WARNING
Failure to observe a warning may result in personal injury, death or equipment damage.

DANGER - Risk of electrical shock or ARC FLASH
Disconnect equipment from line voltage. Failure to observe this warning may result in personal injury, death, or
equipment damage. ARC Flash may cause blindness, severe burns or death.

WARNING - Wear personal protective equipment
Failure to observe may result in serious injury.

WARNING - Do not touch
Failure to observe this warning may result in personal injury, death, or equipment damage.

CAUTION
Failure to observe a caution may result in equipment damage.

ELECTROSTATIC SENSITIVE DEVICES
This equipment may contain electrostatic devices.

Qualified Personnel

Important Information
The term qualified personnel is defined here as individuals who thoroughly understand the equipment and its safe
operation, maintenance and repair. Qualified personnel are physically capable of performing the required tasks, familiar
with all relevant safety rules and regulations and have been trained to safely install, operate, maintain and repair the
equipment. It is the responsibility of the company operating this equipment to ensure that its personnel meet these
requirements.
Always use required personal protective equipment (PPE) and follow safe electrical work practice.
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A.0 Introduction to Safety

CAUTION
Unsafe Equipment Use
This equipment may contain electrostatic devices, hazardous voltages and sharp edges on components

• Read installation instructions in their entirety before starting installation.
• Become familiar with the general safety instructions in this section of the manual before installing,

operating, maintaining or repairing this equipment.
• Read and carefully follow the instructions throughout this manual for performing specific tasks and

working with specific equipment.
• Make this manual available to personnel installing, operating, maintaining or repairing this

equipment.
• Follow all applicable safety procedures required by your company, industry standards and

government or other regulatory agencies.
• Install all electrical connections to local code.
• Use only electrical wire of sufficient gauge and insulation to handle the rated current demand. All

wiring must meet local codes.
• Route electrical wiring along a protected path. Make sure they will not be damaged by moving

equipment.
• Protect components from damage, wear, and harsh environment conditions.
• Allow ample room for maintenance, panel accessibility, and cover removal.
• Protect equipment with safety devices as specified by applicable safety regulations
• If safety devices must be removed for installation, install them immediately after the work is

completed and check them for proper functioning prior to returning power to the circuit.

Failure to follow this instruction can result in serious injury or equipment damage

Additional Reference Materials

Important Information

• IEC - International Standards and Conformity Assessment for all electrical, electronic and related technologies.

• IEC 60364 - Electrical Installations in Buildings.

• CSA - C22.2 No.180:13 (R2018) Series isolating transformers for airport lighting

• FAA Advisory: AC 150/5340-26 (current edition), Maintenance of Airport Visual Aid Facilities.

• Maintenance personnel must refer to the maintenance procedure described in the ICAO Airport Services Manual,
Part 9.

• ANSI/NFPA 79, Electrical Standards for Metalworking Machine Tools.

• National and local electrical codes and standards.

A.0 Intended Use

CAUTION
Use this equipment as intended by the manufacturer
This equipment is designed to perform a specific function, do not use this equipment for other purposes

• Using this equipment in ways other than described in this manual may result in personal injury, death
or property and equipment damage. Use this equipment only as described in this manual.

Failure to follow this instruction can result in serious injury or equipment damage
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A.0 Material Handling Precautions: Fasteners

DANGER
Foreign Object Damage - FOD
This equipment may contain fasteners that may come loose - torque properly.

• Only use fasteners of the same type as the one originally supplied with the equipment.
• Use of incorrect combination of gaskets, bolts and nuts can create severe damages to the product

installation and create safety risk .
• You need to know what base the light fixture will be installed in, in order to chose the correct gasket,

bolts and nuts.
• Bolt type, length, and torque value are determined by type of base, height of spacers used, and clamp

force required in FAA Engineering Brief No 83 (latest revision).
• Due to the risk of bolts vibrating loose, do not use any type of washer with the fixing bolts (such as

split lock washers) other than an anti-vibration washer. Anti-vibration washers as defined in FAA EB
83 (latest edition) must be used. For installations other than FAA, use the base can manufacturer's
recommendations.

• Always tighten the fasteners to the recommended torque. Use a calibrated torque wrench and apply
the recommended adhesive type.

• Obey the instructions of the adhesives necessary for the fasteners.

Failure to follow these warnings may cause the fasteners to loosen, damage the equipment,
potentially to loosen the equipment. This can lead to a highly dangerous situation of FOD, with
potential lethal consequences.

Note
To minimize the risk of errors, the ADB SAFEGATE Sales Representative will have information on which gasket goes
with which base. This information is also provided in the product Data sheets, the User Manuals and the Spare Part
Lists.

CAUTION
Use of incorrect combination of gaskets, bolts and nuts can create severe damages to the product installation and
create multiple safety risks.
To obtain a safe and watertight installation the O-ring and retaining bolt stated in the document must be used.
You need to know what base the light fixture will be installed in, in order to choose the correct gasket, bolts and nuts.
Failure to follow these cautions can result in equipment damage or aircraft FOD.
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A.0 Operation Safety

CAUTION
Improper Operation
Do Not Operate this equipment other than as specified by the manufacturer

• Only qualified personnel, physically capable of operating the equipment and with no impairments in
their judgment or reaction times, should operate this equipment.

• Read all system component manuals before operating this equipment. A thorough understanding of
system components and their operation will help you operate the system safely and efficiently.

• Before starting this equipment, check all safety interlocks, fire-detection systems, and protective
devices such as panels and covers. Make sure all devices are fully functional. Do not operate the
system if these devices are not working properly. Do not deactivate or bypass automatic safety
interlocks or locked-out electrical disconnects or pneumatic valves.

• Protect equipment with safety devices as specified by applicable safety regulations.
• If safety devices must be removed for installation, install them immediately after the work is

completed and check them for proper functioning.
• Route electrical wiring along a protected path. Make sure they will not be damaged by moving

equipment.
• Never operate equipment with a known malfunction.
• Do not attempt to operate or service electrical equipment if standing water is present.
• Use this equipment only in the environments for which it is rated. Do not operate this equipment

in humid, flammable, or explosive environments unless it has been rated for safe operation in these
environments.

• Never touch exposed electrical connections on equipment while the power is ON.

Failure to follow these instructions can result in equipment damage

A.0 Maintenance Safety

DANGER
Electric Shock Hazard
This equipment may contain electrostatic devices

• Do not operate a system that contains malfunctioning components. If a component malfunctions,
turn the system OFF immediately.

• Disconnect and lock out electrical power.
• Allow only qualified personnel to make repairs. Repair or replace the malfunctioning component

according to instructions provided in its manual.

Failure to follow these instructions can result in death or equipment damage
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A.0 Material Handling Precautions: Fasteners

DANGER
Foreign Object Damage - FOD
This equipment may contain fasteners that may come loose - torque properly.

• Only use fasteners of the same type as the one originally supplied with the equipment.
• Use of incorrect combination of gaskets, bolts and nuts can create severe damages to the product

installation and create safety risk .
• You need to know what base the light fixture will be installed in, in order to chose the correct gasket,

bolts and nuts.
• Bolt type, length, and torque value are determined by type of base, height of spacers used, and clamp

force required in FAA Engineering Brief No 83 (latest revision).
• Due to the risk of bolts vibrating loose, do not use any type of washer with the fixing bolts (such as

split lock washers) other than an anti-vibration washer. Anti-vibration washers as defined in FAA EB
83 (latest edition) must be used. For installations other than FAA, use the base can manufacturer's
recommendations.

• Always tighten the fasteners to the recommended torque. Use a calibrated torque wrench and apply
the recommended adhesive type.

• Obey the instructions of the adhesives necessary for the fasteners.

Failure to follow these warnings may cause the fasteners to loosen, damage the equipment,
potentially to loosen the equipment. This can lead to a highly dangerous situation of FOD, with
potential lethal consequences.

Note
To minimize the risk of errors, the ADB SAFEGATE Sales Representative will have information on which gasket goes
with which base. This information is also provided in the product Data sheets, the User Manuals and the Spare Part
Lists.

CAUTION
Use of incorrect combination of gaskets, bolts and nuts can create severe damages to the product installation and
create multiple safety risks.
To obtain a safe and watertight installation the O-ring and retaining bolt stated in the document must be used.
You need to know what base the light fixture will be installed in, in order to choose the correct gasket, bolts and nuts.
Failure to follow these cautions can result in equipment damage or aircraft FOD.

A.0 Material Handling Precautions, ESD

CAUTION
Electrostatic Sensitive Devices
This equipment may contain electrostatic devices

• Protect from electrostatic discharge.
• Electronic modules and components should be touched only when this is unavoidable e.g. soldering,

replacement.
• Before touching any component of the cabinet you shall bring your body to the same potential as the

cabinet by touching a conductive earthed part of the cabinet.
• Electronic modules or components must not be brought in contact with highly insulating materials

such as plastic sheets, synthetic fiber clothing. They must be laid down on conductive surfaces.
• The tip of the soldering iron must be grounded.
• Electronic modules and components must be stored and transported in conductive packing.

Failure to follow this instruction can result in equipment damage
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1.0 Description

Figure 1: Series circuit system overview

A Input power supply
B Manual switch
C Remote control system

D Equipment
E Output disconnection device (optional)
F Series circuit

The equipment is a microprocessor-controlled Constant Current Regulator with an optional output disconnection device
(circuit selector).

1.1 Intended Use

The equipment is designed to convert an AC sine wave input voltage into an adjusted output current selected in brightness
steps to supply a series AGL circuit.

Any other or additional use will not considered to be in conformity with the purpose.

Do not operate the equipment outside the limits of the specifications or outside the specified ambient conditions.
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1.2 Working Principle

A Line input. See Line input

B Precharge PCB. See Line input

C Diode bridge and sensing PCB.See IGBT power bridge

D Capacitor bank. See Capacitor bank

E IGBT module and IGBT PCB. See IGBT power bridge

F Output filter. See Output filter

G Main transformer. See Main transformer, all cabinets

H Output measure PCB. See Output measure PCB (EPS422), all cabinets

I Lightning arrestors. See Power output

J Series output connection. See Power output

K CPU PCB. See CPU PCB (EPS479), all cabinets

Constant Current Regulator Type VIS
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L HMI. See HMI

M Remote control PCB. See Remote control PCB (EPS495 or EP00047), all cabinets

N Power supply PCB. See Power supply PCB (EPS480), all cabinets

Legend

• Red lines: current

• Green lines: signal wires connections

• Black lines: low voltage connections

Current regulation

The equipment converts the single phase input voltage line into a rectified current and voltage. The equipment then converts
this DC current and voltage into a pure sine wave with a defined power rating.

Main feedback loop

The output measure PCB sends the measured output to the CPU PCB. Depending on the output, the CPU PCB automatically
generates a signal to adjust the regulation.
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1.3 Layout of the Equipment Cabinet

1.3.1 Outside - small cabinet: 2.5 to 15 kVA

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

E Remote control connector

F Series output connection. The illustration shows the SCO

G Output to Series Circuit

H Ethernet connector

I Power supply cable entry

Constant Current Regulator Type VIS
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1.3.2 Inside - small cabinet: 2.5 to 15 kVA
Figure 2: The 5 kVA cabinet

A CPU PCB (EPS479)

B Main fuses

C Main contactor

D Precharge contactor

E IGBT module and IGBT PCB (EPS477)

F Precharge PCB

G Diode bridge and sensing PCB (EPS 540 / EPS541)

H Power supply PCB (EPS480)

I Output filter

J Remote control PCB (EPS495)

K Lightning arrestors

L Output measure PCB (EPS422)

M Input terminals

N Line filter

O Main transformer

P Capacitator bank

Q Power supply transformer

R Sensing transformer
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1.3.3 Outside - big cabinet 20 to 30 kVA

A Ventilation grids

B HMI

C Serial communication port

D Manual switch

E Remote control connector

F Series output connection. The illustration shows the SCO

G Output to Series Circuit

H Ethernet connector

I Power supply cable entry

Constant Current Regulator Type VIS
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1.3.4 Inside - big cabinet 20 to 30 kVA
Figure 3: The 20 kVA cabinet

A Line filter

B Output filter

C Power supply PCB (EPS480)

D Sensing transformer

E Power supply transformer

F CPU PCB (EPS479)

G Sensing PCB (EPS497)

H Diode bridge

I Precharge PCB (PCB456)

J Main fuses

K Main contactor

L IGBT module

M IGBT PCB (EPS496/ EPS478)

N Precharge contactor

O Capacitator bank

P Lightning arrestors

Q Remote control PCB (EPS495)

R Output measure PCB (EPS422)

S Input terminals

T Main transformer

1.4 Components

For the exact location and connectors see Layout of the Equipment Cabinet and the electrical scheme. You can find the
electrical scheme attached on the outside of the equipment.
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1.4.1 Line input
Figure 4: Input terminal, all cabinets

The input terminal connects the power input cables to the equipment.

Figure 5: Line filter, all cabinets

The line filter blocks the noise the equipment generates to the line input and filters out voltage pulses from the input voltage.

Figure 6: Manual switch, all cabinets

Constant Current Regulator Type VIS
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The manual switch is a magneto-thermal switch that connects the mains power supply to the equipment. You can manually
set the switch to the ON or OFF position.

Figure 7: Main fuses, small cabinet

The main fuses disconnect the equipment from the mains power supply if the input current is above a given value.

Figure 8: Main fuses, big cabinet

The main fuses disconnect the equipment from the mains power supply if the input current is above a given value.

Figure 9: Main contactor, small cabinet

The main contactor allows the power supply PCB to automatically interrupt the power.

Figure 10: Main contactor, big cabinet
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The main contactor allows the power supply PCB to automatically interrupt the power.

Figure 11: Precharge contactor, small cabinet

The precharge contactor allows a smooth charge of the capacitors on the capacitor bank.

Figure 12: Precharge contactor, big cabinet

The precharge contactor allows a smooth charge of the capacitors on the capacitor bank.

Figure 13: Precharge PCB (EPS456), all cabinets

The resistors on the precharge PCB limit the current for the precharge of the capacitor bank.

Figure 14: Sensing transformer, all cabinets

Constant Current Regulator Type VIS
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The sensing transformer measures the difference in the input voltage level between phases L1 and L2.

Figure 15: Power supply transformer, all cabinets
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The power supply transformer:

• Measures the input voltage level between phases L2 and L3.

• Provides the correct current and voltage to power all the electronic components such as PCBs and to power the fans (for
15 to 30kVA equipment).

1.4.2 IGBT power bridge
Figure 16: Diode bridge + sensing PCB (EPS540 / EPS541), small cabinet

The diode bridge converts the AC line input to a rectified current and voltage.

Note
The sensing PCB measures the AC input line.

Note
In the small cabinet, the sensing PCB and the diode bridge are combined into one part.

Figure 17: Sensing PCB (EPS497), big cabinet

Note
The sensing PCB measures the AC input line and controls the diode bridge.

Constant Current Regulator Type VIS
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Note
In the big cabinet, the sensing PCB and the diode bridge are separate parts.

Figure 18: Diode bridge, big cabinet

The diode bridge converts the AC line input to a rectified current and voltage.

Note
In the big cabinet, the sensing PCB and the diode bridge are separate parts.

Figure 19: IGBT, all cabinets

An IGBT controls a high power via a low power electronic signal.

The IGBT can switch at high frequency.

Two IGBTs are installed together in one housing.

The system uses four IGBTs connected as an H-bridge to make an AC-signal.

Figure 20: IGBT PCB (EPS477 /EPS496 /EPS 478), all cabinets

The IGBT PCB measures the output signal from the IGBT H-bridge.
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1.4.3 Capacitor bank
The capacitor bank smoothens the DC current and voltage to make a constant DC current and voltage.

Figure 21: Capacitor bank, small cabinet

Figure 22: Capacitor bank, big cabinet

1.4.4 Hall sensor, big cabinet
Figure 23: Hall sensor, big cabinet

The Hall sensor measures the current between the IGBT and the output filter.

Constant Current Regulator Type VIS
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1.4.5 Output filter
Figure 24: Output filter, small cabinet

The output filter is a Pulse Width Modulation (PWM) filter that builds the pure sine wave signal that comes from the H-bridge.

Figure 25: Output filter, big cabinet

The output filter is a Pulse Width Modulation (PWM) filter that builds the pure sine wave signal that comes from the H-bridge.

1.4.6 Main transformer, all cabinets

The main transformer converts the pure sine wave to the correct output voltage and current.
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1.4.7 Output measure PCB (EPS422), all cabinets

The output measure PCB measures the output voltage and current and sends these measurements to the CPU PCB.

The EFD (See Earth Fault Detection (EFD) ) and LFD (See Lamp Fault Detection (LFD)) logic is also located on the output
measure PCB.

1.4.8 Power output

Lightning arrestors, all cabinets

• The lightning arrestors are installed on the power output. The lightning arrestors are varistors.

• A varistor is a surge protection device that is connected directly across the AC output.

Connection to the series circuit

• There are mutual exclusive options possible. See Options.

1.4.9 CPU PCB (EPS479), all cabinets

Constant Current Regulator Type VIS
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The CPU PCB:

• Receives the measurement data of the output current and voltage from the output measure PCB via an optical fibre and
compares these values with the required values. A software algorithm processes this data to adjust the signals from the
output filters.

• Receives and processes input signals from the HMI and the remote control PCB.

1.4.10 Remote control PCB (EPS495 or EP00047), all cabinets

Note
Until 2022, the VIS was delivered with the EPS495 board as the remote control PCB. Since 2022, the VIS has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities
of these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems
with a redundant bus. For VIS units equipped with the EPS495, there are options to transition to the EP00047 (and
the EP00051 add-on if needed) when required. Please contact your ADB Safegate representative for more details if
needed.

The equipment can be monitored or controlled remotely with J-Bus (2-wire RS485), multiwire or ethernet. This remote control
allows the remote control system to:

• Receive information about the equipment.

• Configure the brightness steps.

• Test the equipment.

The remote control PCB connects the equipment to the remote control system. The internal connection between the remote
control PCB and the CPU PCB goes through an optical fibre.

Note
For EPS495, remote control through an ethernet connection requires an additional PCB. See Ethernet PCB (EPS542), all
cabinets.

Note
For EP00047, Multiwire support requires an add-on PCB, EP00051.
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1.4.11 Power supply PCB (EPS480), all cabinets

The power supply PCB provides the power supply for:

• All electronic components such as PCBs of the equipment

• The fans (for 15 to 30 kVA equipments)

• The control for the main contactor

The power supply PCB also manages the safety switches on the panels.

1.4.12 Lamp Fault Detection (LFD)
The equipment analyses the output current and the voltage pattern to calculate, on a linear load, the number of open
circuited lamps, in compliance with IEC 61822:2009.

The accuracy is ± 1 lamp with a range from 1 to 15 broken lamps.

The HMI shows the actual LFD value.

1.4.13 Earth Fault Detection (EFD)
The EFD measures the insulation resistance between the series circuit and the earth in compliance with IEC 61822:2009.

The EFD module works when the equipment is connected to the mains supply, even if no output current is present.

You can set two alarm levels, Level 1 and Level 2, for the measured values. Both alarm levels can be set to any value between 5
kOhm and 500 MOhm. However, Level 1 must always be higher than Level 2.

Working principle: A high-voltage resistor applies a stable, current-limited voltage of 450 VDC between the series circuit and
the earth or cable screen.

The HMI shows the actual EFD value.

Note
EFD measurement is done through a DC voltage with a positive voltage applied on to the series circuit and the 0
(zero) to the earth.

1.4.14 Ventilation
The equipment has air ventilation grids for air inlet and air outlet. The air circulation cools the equipment. For 15 to 30 kVA
equipments, additional fans cool the equipment.
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1.5 Options

1.5.1 Remote control

Note
Until 2022, the VIS was delivered with the EPS495 board as the remote control PCB. Since 2022, the VIS has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities
of these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems
with a redundant bus. For VIS units equipped with the EPS495, there are options to transition to the EP00047 (and
the EP00051 add-on if needed) when required. Please contact your ADB Safegate representative for more details if
needed.

The following remote control connections are possible:

• Ethernet (Ethernet PCB required for EPS495)

• Single

• Double

• J-Bus

• Single

• Double

• Multiwire with 8 input signals and 17 output signals, always possible to monitor via single J-Bus. For CRE units equipped
with EP00047, the add-on board EP00051 is also required.

1.5.2 Ethernet PCB (EPS542), all cabinets

Note
This applies to CRE units equipped with EPS495.

 .

The ethernet PCB converts the ethernet to an RS-485 signal. This PCB is required for EPS495 if you need to remotely operate
the equipment through an ethernet connection.

The illustration shows a double ethernet connection.
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1.5.3 Series Connector Box (SCB), all cabinets

The SCB connects the equipment to the series circuit with two medium voltage cables of the primary circuit. The SCB does
not allow the short circuit connection.

1.5.4 Series CutOut (SCO), all cabinets

The SCO acts as an output disconnection device between the equipment and the series circuit. The SCO also isolates the
series circuit from the equipment during maintenance or testing operations. The cover is locked with a key to prevent
unauthorized access.

1.5.5 Rolling castors
The equipment can be supplied with two fixed and two pivoting rolling castors to facilitate the movement of the equipment.
The option is not available for stackable equipments or for an equipment with a CS.

1.6 HMI

You can operate the equipment with the HMI.
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1.7 Nameplate

Each equipment has a standard nameplate:
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2.0 Description of the HMI

Figure 26: HMI overview

A. Display

B. Function buttons

C. Keypad

D. On, Off, Enter, Cancel, Remote and Local buttons

2.1 Display overview: Main screen

Table 1: Display description: Main screen
Name Description

A Menu Push the corresponding function button to go to the Main menu

B Mode indication Shows the state, LOCAL or REMOTE

C State The state can be OFF or ON

D Brightness level OFF, or BRIGHTNESS 0 to 5. Optionally, more levels are possible.
If the display shows BRIGHTNESS 0, this means that the equipment has a pre-defined current as output,
due to a remote control loss

E Field circuit Shows the name of the field circuit that the equipment delivers power to

F True RMS output voltage Shows the true RMS output voltage in kV
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Table 1: Display description: Main screen (Continued)
Name Description

G True RMS output current Shows the true RMS output current in A

H Highest brightness step
counter

Shows the time that the equipment operates at the maximum brightness step in h

I Total brightness counter Shows the total time that the equipment is set to ‘on’ in h

J EFD indicator Shows the measurement of the resistance to earth. The equipment continuously measures the value, also
when the equipment is in the OFF state, when the equipment has power

K LFD indicator In normal mode (linear load): Shows the number of broken lamps if the LFD is calibrated
In inductive mode (non-linear load): Shows the text ‘inductive’

L Software version Shows the current software version

M Power rating Shows the power rating of the equipment

2.2 Description of general functions

The buttons can have different functions. The display description indicates the dedicated functions. This section shows the
general functions, which are available in several menus.

Table 2: General function buttons
Button Description

→ To go to the next submenu

← To go to the previous submenu

ESC To go to the higher level menu

- To decrease the value

+ To increase the value

YES To confirm the selection

NO To decline the selection

SAVE To save an alphanumeric or numeric string

UP, DOWN, LEFT,
RIGHT

To move the cursor in the display

Constant Current Regulator Type VIS
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2.3 Main menu

Table 3: Display description: Menu screen
Name Description

A ESC To return to the Main menu. See Main menu

B OPTIONS To go to the Options menu. See Options menu

C ALARMS To go to the Alarms menu. See Alarms menu

D MAINT To got to the Maintenance menu. See Maintenance menu

2.4 Options menu

Table 4: Buttons
Button Description

RS232/485 To activate or deactivate the RS232 or RS485 port

MODE To select the correct equipment work mode (see Operation mode):

• NORMAL (for linear loads)

• INDUCTIVE (for non-linear loads (e.g. LED loads))

ID To change the name of the field circuit that the equipment powers. See How to enter an alphanumeric string
how to enter an alphanumeric string with the HMI

SLVNUM To change the address number of the equipment in the RS485 network

LANG To change the language of the display

CONTR To change the display contrast

LFD To calibrate the LFD

HCOUNT To reset the HOURS indicator

2.5 Alarms menu

Table 5: Buttons
Button Description

RESET To reset the alarm: See also Alarms

FORWARD To show the previous alarm in the list: See also Alarm texts and messages on the HMI .
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For an overview of alarm texts and messages, see Alarm texts and messages on the HMI

2.6 Maintenance menu

A password is required to access the maintenance menu.

Table 6: General function buttons
Button Description

TEST Shows the DSP microcontroller operating parameters. These parameters show the state of the software
process that controls the equipment. These parameters are only for an advanced user.

MORE To go to more submenus:

• IGBT TEST
A verification test of the IGBT.

• INPUT FREQ
Do not change this parameter.

• REMOTE CONTROL MODE
Multiwire or J-Bus

• JBUS PROTOCOL
MCR2 protocol or MCR3 protocol

• CSE/MODE
Activate circuit selector. Yes or No.

• JBUS mode
485 or Ethernet mode

• MULTIWIRE CONFIGURATION
To configure the output pins of the multiwire connector. You can change the connector function with the
ON and OFF buttons. To save the configuration, push the ENTER button.

• V/I CALIBRATION
Do not use this parameter.

• ETHERNET CONFIGURATION
Only for an equipment with the Ethernet Remote Control PCB. To configure the 2 IP addresses.

2.7 Mode menu

Table 7: General function buttons
Button Description

RAMP TIME The time that the equipment takes to change from one brightness step to another, in seconds (0 to 125 s).

HALFWAVE WIDTH To enhance the current peak. You can decrease the half wave width and so reshape the sinosoidal waveform
(50 to 100%). The default value is 100% (no enhancement).

MAX PWM WIDTH To smoothen the maximum current the equipment can supply to prevent a too high current to run on the
lamps. You can reduce maximum power threshold on the PWM cycle (1 to 100%). The default value is 100%
(no threshold on the current output).

CURRENT LIMIT Maximum peak current

PID TYPE Do not change this parameter

2.8 How to enter an alphanumeric string

1. The display shows an alphanumerical matrix (B).

2. Push the LEFT and RIGHT buttons to select the character.

3. Push the ENTER button. The HMI adds the character to the string (A).
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4. Push the CANCEL button to delete the last character.

5. Push the SAVE button to confirm the string.

2.9 Alarm texts and messages on the HMI

There are four types of alarms:

• Equipment alarms

• The equipment automatically switches OFF. Restart the equipment only after you have found the cause of the alarm.

• The red light goes on but the equipment still operates. Find the cause of the alarm.

• Field alarms

• The equipment automatically switches OFF. Restart the equipment only after you have found the cause of the alarm.

• The red light goes on but the equipment still operates. Find the cause of the alarm.

Alarm text / message Possible cause
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450V EFD MISSING The 450 V EFD test voltage is missing x x

560VDC BUS OVERCURRENT The current on the primary power transformer is too
high

x x

ALARM!!! Several alarms have occurred at the same time x x

BAD REGULATION The current did not reach the selected level within the
ramp up time

x x

DSP ERROR OR WRONG
FIRMWARE

The CPU DSP has failed or the DSP firmware is
corrupted

x x

EFD LEVEL 1 FAULT The resistance to earth is less than level 1 (20 MOhm
default value)

x x

EFD LEVEL 2 FAULT The resistance to earth is less than level 2 (2 MOhm
default value)

x x
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Alarm text / message Possible cause
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GATE H FAULT There is a problem with the H-bridge (IGBT). On the
HMI, a message shows “IGBT KO: xxx x”

x x

IGBT KO: ... Both IGBTs are broken x x

IGBT KO: BTM A The IGBT A is broken x x

IGBT KO: TOP A The IGBT A is broken x x

IGBT KO: BTM B The IGBT B is broken x x

IGBT KO: TOP B The IGBT B is broken x x

IGBT KO: TOP BTM A The IGBT A is broken x x

IGBT KO: TOP BTM B The IGBT B is broken x x

INPUT VOLTAGE TOO HIGH The input voltage is too high x x

INPUT VOLTAGE TOO LOW The input voltage is too low. This can lead to an over
current situation

x x

LFD LEVEL 1 FAULT Minimum 3 broken lamps x x

LFD LEVEL level 2 fault Minimum 5 broken lamps x x

MAIN CONTACTOR FAILED (OFF) The main contactor is broken x x

MAIN CONTACTOR FAILED (ON) The main contactor is broken x x

MAIN DC <95% The rectified 560 V DC voltage is too low. (Only applies
to 3 phase input)

x x

MAIN REMOTE CTRL SWITCH OFF The main remote control switch does not go on when
the microprocessor gives an ‘on’ command

x x

MAIN REMOTE CTRL SWITCH ON The main remote control switch goes on before the
microprocessor gives an ‘off’ command

x x

MANY ERRORS HAVE HAPPENED,
DURING CONTROL

Different alarms are generated in the same alarm time
interval after the equipment startup phase

x x

MANY ERRORS HAVE HAPPENED,
DURING ON

Different alarms are generated in the same alarm time
interval during the equipment startup phase

x x

NO FAN One or more fans do not operate correctly x x

ONE PHASE MISSING One phase is missing. The display shows which phase
is missing

x x

OPEN CIRCUIT The output circuit is interrupted. Link the cable
correctly before you restart the equipment

x x

OVERCURRENT • The output current is more than lmax +5% for
minimum 4s

• The output current is more than Imax + 20% for
minimum 0.4 s

x x
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Alarm text / message Possible cause
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OVERLOAD The load of the equipment is too high x x

OVERVOLTAGE FROM FIELD The “IGBT OVP” has stopped the equipment when it
could not find a suitable operation mode after several
retries

x x

PHASE ERROR There is a problem with the mains frequency detection x x

PIC COMMUNICATION ERROR A faulty communication with the measurement PCB x x

PRE-CHARGE CONTACTOR ON The pre-charge contactor is broken (VIS only) x x

PRE-CHARGE CONTACTOR OFF The pre-charge contactor is broken (VIS only) x x

SCO / DOOR OPENED A front, rear and or field connection panel is open x x

TEMPERATURE SENSOR FAULT There is a fault in the temperature measurement circuit x x

TLC ERROR There is an error on the remote control PCB x x

TOO HIGH TEMPERATURE The temperature of the heat sink is too high x x

V IN UNSTABLE The input voltage is not stable x x

VA DROP LEVEL EXCEEDED The output power goes below a preset level x x
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3.0 Description of the configuration software tool

With the configuration software tool, you can:

• Read the state of the equipment (alarms, output current, input current)

• Read the configuration of the equipment

• Adjust the configuration of the equipment

• Test the equipment

• Send writing and reading commands to the equipment

WARNING
When you activate the configuration tool, you transfer all control of the equipment to the configuration software
tool. In this situation, remote or local control of the equipment is not possible.

To update the software version, contact ADB Safegate.

3.1 Description of screens and menus

Figure 27: General

Description

A Slave To select the slave number of the equipment you want to connect to

B Connection To open and close the port to the selected slave number

C Rem Reset To reset the alarm. See also Alarms

D Restore
configuration

To restore a saved configuration from the PC to the equipment

E Save configuration To make the values sent to the equipment active on eeprom
The values you send to the equipment are not active on the eeprom

F Default
configuration

To return to the factory default configuration

G Message bar Shows communication messages and error messages about the software configuration tool

H Exit To exit the configuration software tool

UM-6007, Rev. 2.2, 2024/07/17 31
Copyright © ADB Safegate, All Rights Reserved



You can adjust the values in the yellow areas (A).

You cannot adjust values in the orange areas (B).

White selection boxes: if the box is marked, the item applies (C).

3.2 CCR status screen

Description

A Active step Shows the active brightness step of the selected equipment

B Burnt lamps Shows the number of burnt lamps in the series circuit

C CCR Status See CCR Status

D EFD Errors See EFD Errors

E Bus Error Only applies to a double J-Bus or Ethernet connection

F LFD Errors See LFD Errors

G Regulation Errors See Regulation Errors

H CCR Errors See CCR Errors

I Mains Voltage Errors See Mains Voltage Errors

J Output See Output

K Start To show the parameters of the selected slave equipment

L Stop To stop to show the parameters of the slave equipment
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Description of the configuration software tool

32
Copyright © ADB Safegate, All Rights Reserved



3.2.1 CCR Status

Item Description

Event An error event occurred

DB Chgd A change was made to the database

DB Valid The data in the database is up to date

CCR Master • LOCAL SELECTOR: the master is in LOCAL mode

• PC: the RS232 port of the master is active

• BUS A. The J-BUS is active and the master is in REMOTE mode

3.2.2 EFD Errors

Possible cause Alarm type

Level 1 exceeded The resistance to earth is less than level 1 (20 MOhm
default value)

The red light on the equipment goes on

Level 2 exceeded The resistance to earth is less than level 2 (2 MOhm
default value)

450V supply out of range The 450 V EFD test voltage is missing

Scale Shows 0 for a 20 pA EFD scale and 1 for a 200 pA EFD scale

Isolation resistance Shows the isolation resistance value (0 to 500 MOhm)

3.2.3 LFD Errors

Possible cause Alarm type

Level 1 of Burnt Lamps is exceeded Minimum 3 broken lamps The red light on the equipment goes on

Level 2 of Burnt Lamps is exceeded Minimum 5 broken lamps

Level 1 VA-Drop is exceeded The output power goes below a preset level

Level 2 VA-Drop is exceeded The output power goes below a preset level

Error in LFD Reference Calibration The LFD reference calibration is not done or is
not successful

Error in LFD Removed Lamps Calibration The LFD removed lamps calibration is not done
or is not successful
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3.2.4 Regulation Errors

Possible cause Alarm type

CCR switched OFF for OVERCURRENT • The output current is more than Imax +5%
for minimum 4s

• The output current is more than Imax + 20%
for minimum 0.4s

• The equipment automatically switches
OFF

• Restart the equipment only after you
have found the cause of the alarm

CCR switched OFF for OPEN CIRCUIT The output circuit is interrupted. Connect the
cable correctly before you restart the equipment

Measure board connector disconnected There is no communication between the CPU
PCB and the measure PCB
Possible root causes:

• The optical cable is disconnected

• The power supply cable is disconnected

• Malfunction of the measure PCB

CCR is in OVERLOAD The load of the equipment is too high

Output current is unstable The output current fluctuates or could not reach
the requested value
Possible root causes:

• Load switching (E.g. Aglas, Brite)

• To much load on the series circuit

3.2.5 CCR Errors

Possible cause Alarm type

DC BUS Voltage too low Only for a three-phase equipment. The voltage on the
DC bus does not reach the nominal value
Possible root causes:

• Malfunction of the IGBT

• The wiring is not connected properly

• The equipment automatically switches OFF

• Restart the equipment only after you have
found the cause of the alarm

Temperature Fault The temperature of the heat sink is too high

SCO/Door opened A front, rear and/or field connection panel is open The red light on the equipment goes on

Main Contactor Fault The main contactor does not switch on when the
microprocessor gives an ‘on’ command
Possible root causes:

• Malfunction of the main contactor

• Malfunction of the feedback of the contactor

• A faulty connection on the power supply PCB

Pre-Charge Contactor Fault The precharge contactor does not go on when the
microprocessor gives an ‘on’ command
Possible root causes:

• Malfunction of the main contactor

• Malfunction of the feedback of the contactor

• A faulty connection on the power supply PCB
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Possible cause Alarm type

Temperature Sensor Fault There is fault in the temperature measurement circuit • The equipment automatically switches OFF

• Restart the equipment only after you have
found the cause of the alarm

Blower Fault One or more fans do not operate correctly

I Primary Fault There is a problem with the current after the IGBT

IGBT Fault The IGBT test did not succeed after the ‘ON step
request’
Possible root causes:

• Malfunction of the IGBT.

• A faulty wiring between the CPU PCB and the IGBT
PCB

• Malfunction of the IGBT PCB

3.2.6 Mains Voltage Errors

Possible cause Alarm type

Mains Voltage too Low The input voltage is too low. This can lead to an over
current situation

• The equipment automatically switches OFF

• Restart the equipment only after you have
found the cause of the alarmMains Voltage too high The input voltage is too high

Mains Voltage unstable The input voltage is not stable The red light on the equipment goes on

3.2.7 Output

Item Description

I_out Shows the output current

V_out Shows the output voltage

P_out Shows the output power

V_in Shows the input voltage

Pwm Shows the PWM
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3.3 Output/Mains screen

Description

A Output screen part See items B to F

B Output currents See Off if overload

C Imax Shows the maximum output current

D Overcurrent See Overcurrent

E Off if overload See Off if overload

F Step parameters See Step Parameters

G Read To read the actual Output parameters from the selected equipment

H Mains See Mains

I SHVS Not used

3.3.1 Output currents

Item Description

Number of Steps To select the number of brightness steps

Brightness 1 to 8 To adjust the current for each brightness step, accurate up to 25 mA

Change To activate the values and to send them to the equipment

Note
When you select less than 8 brightness steps, the steps higher than the highest step automatically get the current of
the highest brightness step.

Example: When you select 4 brightness steps and you select 4.750 A for brightness step 4, brightness steps 5 to 8 are
disabled and get 4.750 A current assigned automatically.
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3.3.2 Off if overload

Item Description

CCR Remains ON To make sure that the equipment remains ON when the equipment is in overload state and the alarm comes
up

CCR Switches OFF To make sure that the equipment switches OFF when the equipment is in overload state and the alarm
comes on

Change To activate the values and to send them to the equipment

3.3.3 Overcurrent

Item Description

Level 1 and Level 2 To set the percentage of the maximum of the two thresholds for overcurrent. The screen part also shows the
actual current threshold values

Delay 1 and 2 To set the delay before the overcurrent alarm comes on, in s

Change To activate the values and to send them to the equipment

3.3.4 Step Parameters

Item Description

Step_Speed To set the time that the equipment takes to change from one brightness step to another, in seconds (0 to 125 s)

Inter_Br To define an intermediate brightness between steps

Change To activate the values and to send them to the equipment

3.3.5 Mains

Item Description

V_in_Scale Shows the scale used to calculate the nominal voltage

V_in_Nom Shows the nominal supply voltage

V_in_High To adjust the supply voltage threshold above which the equipment restarts when switched OFF due to too low
supply voltage

V_in_Low To adjust the supply voltage threshold below which the equipment sounds an alarm and switches OFF

V_in_Warn To adjust the voltage threshold above which the equipment sounds an alarm

Frequency_In Shows the supply voltage frequency

Change To activate the values and to send them to the equipment

Read To read the actual Mains parameters from the selected equipment
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3.4 Test screen

Description

A Read To read the actual Analogue Data parameters (AD0 to AD7) from the selected equipment

B Brightness See Brightness

C Ctrl Hardware Iprim See Ctrl Hardware Iprim

D Switch on JBUS To enable the J-Bus serial port an to disable the RS232 serial port

E Test Overcurrent To start the overcurrent alarm test

F Test JBUS See Test JBUS

3.4.1 Brightness

Item Description

Brightness To select the step

Standby To set the selected equipment to stand-by

Change To activate the values and to send them to the equipment

3.4.2 Ctrl Hardware Iprim

Item Description

I primary hardware
protection

Shows if the primary current hardware protection is released. This is a read-only parameter

Reset To reset the primary current hardware protection

Read To read the actual primary current protection parameter from the selected equipment

3.4.3 Test JBUS

Item Description

N. To select the data line

Value To select the test data value

Read To read the actual JBUS parameters from the selected data line

Write To send the selected test data to the selected data line
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3.5 Configuration screen

Description

A CCR ID See CCR ID

B Change Slave
Number

See Change Slave Number

C Firmware version Shows the firmware version of the selected equipment

D Firmware details Shows a description on the firmware version of the selected equipment

E SN/YearCode See SN/YearCode

F Setup Save Date Shows the date and time of the latest save of the data of the selected equipment. The date and time are
generated from the PC that is connected to the equipment

G Maintenance
Password

See Maintenance Password

H Read To read the actual configuration parameters from the selected data line

I Open Circuit Do not use these parameters. There is a risk of damage to the equipment. Only ADB Safegate service engineers
are allowed to use these parameters

J Regulation Rate

K Regulation
Parameters

3.5.1 CCR ID

Item Description

Blank field To change the name of the field circuit that the equipment delivers power to. This name shows in the HMI

Change To activate the value and to send it to the equipment

3.5.2 Change Slave Number

Item Description

Slave Number To adjust the slave number of the selected equipment

Change To activate the value and to send it to the equipment
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3.5.3 SN/YearCode

Item Description

YearCode/SN To change the production year and the serial number

Change To activate the value and to send it to the equipment

3.5.4 Maintenance Password

Item Description

Old Password Shows the current maintenance password

New Password To adjust the maintenance password

Confirm Password Copy the adjusted maintenance password for confirmation

Change To activate the value and to send it to the equipment

3.6 EFD/LFD screen

Description

A EFD Enable See EFD Enable

B EFD Levels See EFD Levels

C Reset error To reset the EFD error

D Read To read the actual EFD parameters from the selected equipment

E LFD Calibrated Shows if the LFD is calibrated

F LFD not Calibrated Shows if the LFD is not calibrated

G LFD Inh See LFD Inh

H LFD Levels See LFD Levels

I VA Drop + delay See VA Drop + delay

J Read To read the actual LFD and VA Drop parameters from the selected equipment

Constant Current Regulator Type VIS
Description of the configuration software tool

40
Copyright © ADB Safegate, All Rights Reserved



3.6.1 EFD Enable

Item Description

State To select if the EFD measurement is enabled or disabled

Measure If the EFD measurement is enabled, you can choose between these values:

• Interval: the interval between measurements is indicated in the Min-Sec field

• Continuous: the equipment measure continuously. The Min-Sec field is not active

Min-Sec To set the time between measurement if the measurement is set as interval

Change To activate the value and to send it to the equipment

3.6.2 EFD Levels

Item Description

EFD Range Shows the maximum earth leakage value the equipment can measure

EFD Level 1 To adjust the insulation resistance below which the equipment gives the EFD Level 1 alarm

EFD Level 2 To adjust the insulation resistance below which the equipment gives the EFD Level 2 alarm

Change To activate the value and to send it to the equipment

3.6.3 LFD Inh

Item Description

State To select if the LFD is enabled or not

Mode To choose between different LFD modes:

• Normal: both the LFD 1 and 2 Levels are active

• Degraded: only LFD 2 Level is active

Change To activate the value and to send it to the equipment

3.6.4 LFD Levels

Item Description

LFD Level 1 and Level 2 To adjust the threshold above which the equipment gives the LFD Level 1 and Level 2 alarm

Change To activate the value and to send it to the equipment

3.6.5 VA Drop + delay

Item Description

VA Drop1 and Drop2 To adjust the threshold above which the equipment gives the VA Drop 1 and Drop 2 alarm

LFD Delay To adjust the minimum time span after the error before the equipment gives the LFD Level 1 or Level 2 alarm

VA Drop Delay To adjust the minimum time span after the error before the equipment gives the VA Drop 1 or Drop 2 alarm

Change To activate the value and to send it to the equipment
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3.7 Diag/Dsp/BUS screen

Description

A Slave errors See Slave Errors

B Rem Reset See Rem Reset

C Dsp parameters See Dsp Parameters

D Imp Test See Imp Test

E Hours_Meter See Hours_Meter

F Bus Parameters • Arbiter: To set the signal source for remote control. To set a priority for different systems. If you set this
parameter to disabled, remote control is not possible.

• BF Mode: Use normal or stop bar.

• BF Time: The time after which the equipment starts to use the default settings.

• BF Def: To set default values that the equipment uses when the remote control (J-Bus) connection is down
for longer than the time set in the menu. Leave this field blank or set a value from 1 to 8.

• Select either Stay on Prevent step or Go to Bf-Def.

G Speed See Speed

H Read To read the actual J-Bus parameter of the equipments

Note
To show the screen part with the bus parameters, select Options>Advanced.

3.7.1 Slave Errors

Item Description

Read buttons To read the actual slave error from the selected equipment

Tot_Mess Shows the number of messages that the equipment received

Crc_Err Shows the number of messages with checksum that the equipment received

Exception Shows the number of messages with wrong commands that the equipment received

Own_Mess Shows the number of messages that belong to the selected equipment

No_Ack Shows the number of messages for which the equipment did not receive a reply
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Item Description

Overrun Shows the number of messages with overrun that the equipment received

Silent Shows the if the equipment replies to messages:

• 0: the equipment replies to messages

• 1: the equipment does not reply to messages

Test field To test the communication. You can enter a number in the field to test

Test button To test the communication with the value in the test field

Restart Communic.Opt To set all counters to 0 and the silent value to 0

Force Listen Only Mode To set the silent field to 1 and to force the equipment to reply to messages

Clear Counters To set all counters to 0 but not to change the silent value

3.7.2 Rem Reset

Item Description

Rem Reset To enable or disable the Rem Reset button

• 1: the Rem Reset button is enabled

• 0: the Rem Reset button is disabled

Change To activate the value and to send it to the equipment

Read To read the actual Rem Reset parameter from the selected equipment

3.7.3 Dsp Parameters

Item Description

Dsp_Sel To select what the HMI shows optionally. You can choose from four parameters
The HMI only shows the selected parameter

• LAMP: the number of broken lamps

• VA_Out: the VA output

• VA_Out%: the percentage of the VA output

• LMP_Test: to carry out a display test

Desp_Sel_Def To select what the HMI shows optionally. You can choose from four parameters. The HMI shows the selected
parameter, but only for the time indicated in the DSP_Hold field.

• LAMP: the number of broken lamps

• VA_Out: the VA output

• VA_Out%: the percentage of the VA output

• LMP_Test: to carry out a display test

Dsp_Hold To adjust the time the HMI shows the optional parameter

Dec_Separ To adjust the decimal separator for the UI (, or .)

Change To activate the value and to send it to the equipment

3.7.4 Imp Test

Item Description

LEDs To carry out a test on the LEDs of the keyboard on the HMI. The LED adjacent to the DB9 connector comes on

Change To activate the value and to send it to the equipment
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3.7.5 Hours_Meter

Item Description

Total Shows the total time that the equipment is set to ‘on’ in h

Max Br. Shows the time that the equipment operates at the maximum brightness step in h

Read To read the actual hours parameters from the selected equipment

3.7.6 Rem_Reset_Circuit_selector

Item Description

Circuit selector When the boxed is checked, the circuit selector will be reset

Change To activate the value and to send it to the equipment

Read To read the actual Rem Reset parameter from the selected equipment

3.7.7 Speed

Item Description

BaudRate To adjust BaudRate of the J-Bus connection between the equipments

Parity To adjust the parity of the J-Bus connection between the equipments

Change To activate the value and to send it to the equipment. Do not change the speed parameters when you connect the
equipment with the ethernet line

3.8 Copy Parameters screen

Description

A Load parameters
from ccr

See Load parameters from CCR

B Save To save the parameters from the PC to the selected equipment
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3.9 Log screen

Description

A Download To show the history file of the selected equipment in the Log screen

B Save Log To save the log file to the PC

3.10 Test JBus screen

Description

A Start Test To start the test

B Stop To stop the test

C No. of slaves Shows the number of slaves

D Reg. start

E No. of reg
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4.0 Install and operate the configuration software tool

4.1 Install the configuration tool software

System requirements

• PC with Microsoft Windows 2000, XP operation system, or later

• At least 50 Mbytes free disk space

• 1 free serial communication (COM) port, or a virtual serial communication port over a USB bridge or a PCMCIA card

• PC user account with either administrator or power user rights

Move the WINCCR.exe file from the CD-ROM to the hard drive of the PC.

4.2 Start the configuration software tool

Activate the serial port, if applicable

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the SER/JBUS button to go to the SER/JBUS screen.

3. Push the SERIAL button to activate the serial port.

Configure the ethernet port, if applicable

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the MORE button to go to the Mode screen.

3. Push the ETHERNET CONFIGURATION button to configure the ethernet port.

Find the slave number of the equipment

1. On the HMI, push the ESC button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the SLVNUM button to show the slave number.

4. Note the slave number. You will need it for reference later.
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Connect the serial cable, if applicable

1. Switch OFF the equipment. See Switch OFF the equipment.

2. Connect the extension cable to the dongle (A) and to the serial communication port of the PC (B).

Connect ethernet cable, if applicable

1. Switch OFF the equipment. See Switch OFF the equipment.

2. Connect the ethernet cable (B) to the equipment (A) and to the PC (C).

Configure the remote control ethernet connection

1. Make sure that the IP range of the PC is in the same range as the device.

2. Access the web control interface of the device.

3. From the Network Settings control panel, set the IP address, Netmask, and IP configuration to the values of the network
that the Ethernet board uses.

4. From the Serial Settings control panel, make sure that the serial parameters have the values that follow:

• Baud Rate: 9600

• Data Bits: 8

• Stop Bits: 1

• Parity: None

5. From the Operating Settings control panel, make sure that the Port=01 parameters have the values that follow:

• Operation mode: TCP Server Mode

• TCP alive check time: 0

• Inactivity time: 5000

• Max connection: 1
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6. Make sure the Data Packing parameters have the values that follow:

• Delimiter 1: 0: Do not select Enable

• Delimiter 2: 0: Do not select Enable

• Force transmit: 10

7. Make sure the TCP Server Mode parameters have the values that follow:

• Local TCP port: 502

• Do not select Apply the above settings to all serial ports

8. From the Serial Command Mode control panel, make sure the serial parameters have the values that follow:

• Trigger Setting: HW Trigger

• SW Trigger Character: 2B 2B 2B

Start software

1. Switch the equipment ON.

2. Click the WINCCR.exe file in the directory where you installed the software. The configuration tool opens on the CCR
Status screen.

Set up the serial port, if applicable

1. Select the menu Communication.

2. Select the applicable serial communication port (COM).

Note
The baud rate and parity settings for the communication between the PC and the equipment must be the same.
For the dongle, the default baud rate is 9600 and the default parity setting is None.

3. Push the OK button to confirm the settings.

4. Push the Open Port button to open the selected serial port.

• If the settings are correct, the yellow OK button is enabled and the bottom bar shows the message 'Port opened'.

• If the settings are not correct, the bottom bar shows an error message.

Set up the Ethernet port if applicable

1. Select the menu Communication>Ethernet.

2. Select the applicable IP address and Port.

3. Push the OK button to confirm the settings.

4. Push the Open Port button to open the selected serial port.

• If the settings are correct, the yellow OK button is enabled and the bottom bar shows the message 'Port opened'.

• If the settings are not correct, the bottom bar shows an error message.
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4.3 Monitor the data of an equipment

Select the equipment

1. Select the slave number of the equipment you want to monitor.

2. Push the OK button.

Start monitoring

1. Select the CCR status screen. See CCR status screen.

2. Push the Start button. The screen shows the data of the selected equipment.

Stop monitoring

• Push the Stop button. The screen no longer shows the data of the selected equipment.

4.4 Stop the configuration software tool

1. Serial connection: Disconnect the extension cable from the dongle and the PC connector of the equipment.

2. Ethernet connection: Disconnect the ethernet cable from the PC and the equipment.
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5.0 Commissioning

Main commissioning procedure

1. Do the first start-up. See First start-up.

2. Calibrate the Lamp Fault Detection (LFD) module. See Calibrate Lamp Fault Detection (LFD).

3. Adjust the number of available brightness steps. See Adjust number of used brightness steps.

4. Configure the remote control interface (option). See Remote control configuration: multiwire (option), Remote control
configuration: J-Bus (option), or Remote control configuration: ethernet (option), depending on the hardware.

5.1 First start-up

The equipment stores the last request after a power cycle. This means that when the equipment is switched ON, it starts to
produce the same output current that was valid before the equipment was switched OFF.

When you start up the equipment for the first time, the powering-down status is unknown. This procedure allows you to
prevent the equipment from producing the output current at first start-up.

5.1.1 Procedure
1. Measure the input voltage. See Measure input voltage .

2. Measure the output current in short circuit. See Measure output current in short-circuit.

3. Measure the resistance and the insulation resistance of the series circuit. See Measure insulation resistance of series circuit.

4. Measure the output current to the series circuit. See Measure the output current to the series circuit.

5.1.2 Measure input voltage

Prepare

1. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

2. Remove the lower rear panel. See Remove panels.

3. Set the manual switch to the ON position.

4. On the HMI, push the Local button. The screen now shows the state LOCAL.

5. Push the OFF button. The equipment goes to the mode OFF.
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Measure

1. Measure the input voltage on the input terminals (A). Use a True RMS Multimeter.

2. Examine if the voltage is in accordance with:

• The nameplate of the equipment.

• Local regulations.

CAUTION
Excessive input voltage can damage the equipment.

Finish

1. Switch off the power supply. See Switch OFF the power supply.

2. Install the lower rear panel.

5.1.3 Measure output current in short-circuit
1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Put the output in short-circuit. For SCB, see Put SCB in short-circuit. For SCO, see Put SCO in short circuit.

3. Measure the output current in short-circuit. See Measure the output current in short circuit.

4. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

5. If you use an SCB: Remove the separate piece of cable and connect the series circuit cables. See Put SCB in short-circuit.

6. If you use an SCO: set the SCO to mode A. See Operation mode.

5.1.4 Put SCB in short-circuit

Strip cables
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Strip a separate piece of series circuit cable at both ends.

• A: unscreened cables

• X: 16 mm

• Ø Y: less than or equal to 18 mm

• B: unscreened cables

• X: 16 mm

• Ø Y: less than or equal to 18 mm

• U: 11 mm

• Z: 77 mm

Remove the box panel of the SCB

1. Loosen the screws (A).

2. Remove the box panel (B).

Short circuit SCB with separate piece of output cable

1. Disconnect the series circuit cables.

2. With the separate piece of output cable (B), short-circuit the output terminals (A).

3. Install the box panel.

5.1.5 Put SCO in short circuit
Set the SCO to mode C. See Operation mode
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5.1.6 Measure the output current in short circuit

Connect AC True RMS multimeter (SCB)

• Connect the current clamp of an AC True RMS multimeter (B) to the short-circuited cable (A).

Connect AC True RMS multimeter (SCO)

• Connect the current clamp of an AC True RMS multimeter (B) to the output cable (A).

Measure output current

1. Switch ON the equipment and set it to LOCAL mode. See Operation.

2. Select the step 6.6 A.

3. Read the output current value from the AC True RMS Multimeter.

4. Repeat the previous steps and examine the output current value for each brightness step. Check each brightness step
separately from the highest to the lowest level.

5.1.7 Measure resistance and the insulation resistance of series circuit
1. Prepare the series circuit. For SCB, see Prepare with SCB. For SCO, see Prepare with SCO.

2. Measure the resistance of the series circuit. See Measure resistance of series circuit.

3. Measure the insulation resistance of the series circuit. See Measure insulation resistance of series circuit.

4. Calculate minimum insulation resistance of series circuit. See Calculate minimum insulation resistance of series circuit.

5. Calculate resistance of series circuit See Calculate resistance of series circuit.

6. Complete the activities. See Complete the measurement.
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5.1.8 Prepare with SCB

Set power to OFF

• Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

Remove the box panel

1. Loosen the screws (A).

2. Remove the box panel (B).

Discharge the output terminals

1. Discharge the output terminals.

2. Completely remove the series circuit cables, also the shielding, if applicable.

5.1.9 Prepare with SCO

Set power to OFF

1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Set the SCO to mode C. See Operation mode. The output terminals are now discharged.

Remove cover

1. Open the lock (A).

2. Remove the cover (B). Use the handle.

Remove series circuit cables

• Completely remove the series circuit cables, also the shielding, if applicable.
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5.1.10 Measure resistance of series circuit
Measure the resistance: measure on the ends of the series cable (A). Use a multimeter (B), in accordance with local
regulations.

5.1.11 Measure insulation resistance of series circuit
1. Join the ends of the series circuit cables (C).

2. Measure the insulation resistance of the series circuit. Use the insulation tester (E). Megger 5000 V or 10000 V, in
accordance with local regulations.

• A: when the series circuit cable is not shielded

• B: when the series circuit cable is shielded. Measure the earth on the shield (D).

5.1.12 Calculate minimum insulation resistance of series circuit

Table 8: Theoretical insulation resistance for the series circuit
Item Maximum insulation resistance current (standard: ICAO, part 5, § 3.9.4.7)

[μA]

Series transformer 2

100 m of cable with standard number of connectors 1

Example: a runway center-line circuit with 133 light fixtures with a total length of the series circuit of 8 km.

• Allowed insulation resistance current for the transformers is 133 x 2 = 266 μA

• Allowed insulation resistance current the cable is 80 x 1 = 80 μA

• Total allowed insulation resistance current for this circuit is 266 μA + 80 μA = 346 μA

• When you test with 5000 V, according to Ohms law, the minimum resistance is 14 MOhm.

5.1.13 Calculate resistance of series circuit
Rprim = ρ x L/A + y x 0.1212
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Where:

• Rprim = resistance of the series circuit in Ohm

• ρ = 18 x 10-3 (Ohm x mm2)/m

• L = length of the circuit in m

• A = section of the cable in mm2

• y = number of series transformers in the circuit

Example:

circuit length is 8000 m

cable section is 6 mm2

number of series transformers is 122

Then Rprim = (18 x 10-3) x 8000/6 + 122 x 0.1212 = 36.7 Ohm

5.1.14 Complete the measurement
1. Make sure that the measured and the calculated values match and that all the values are in accordance with all local safety

regulations.

2. Connect the series circuit cables to the equipment.

3. Install the cover or the box panel.

5.1.15 Measure the output current to the series circuit

Prepare

1. Make sure that the series circuit is measured and approved. See Measure resistance and the insulation resistance of series
circuit.

2. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

3. Make sure that the series circuit is connected.

4. Connect an AC current clamp (B) to the series circuit cable (A).

Measure

1. Switch ON the equipment and set it to LOCAL mode. See Operation.

2. Select the step 6.6 A.

3. If the output current does not reach 6.6 A, change the series circuit configuration before you proceed. This indicates that
the equipment is too small for the load.

4. Compare the output current reading on the HMI with the reading on the True RMS Multimeter.

5. Examine if the output current readings are in accordance with local regulations. If not, do not continue.
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Check brilliancy level

1. Examine if all light fittings have the same brilliancy level. Go to the runway area to make a visual inspection.

2. Examine all the brightness steps separately. Go through the whole procedure for each brightness step.

Finish

1. Wait for approximately 30 minutes and make sure that he equipment works correctly.

2. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

5.2 Calibrate Lamp Fault Detection (LFD)

Follow this procedure to make sure that the equipment indicates the correct number of broken lamps. See Input filter for the
accuracy of the LFD.

CAUTION
The LFD module does not work if the series circuit includes these types of lights:

• LED lights without the monitoring option

• PVO/PVL lights (guidance signs)

• WIGWAG (runway guard lights)

Make sure that all lamps in the series circuit operate

1. Make sure that the equipment is connected to the series circuit.

2. Switch ON the equipment and set it to LOCAL mode. See Preliminary checks.

3. Set the equipment to the highest brightness step. See Checks and measurements.

4. Examine if all light fittings light up. Go to the runway area to make a visual inspection.

5. Push the OFF button on the UI.

Select LFD calibration

1. On the HMI, push the Options button to go to the Calibrate Lamp Fault Detection menu.

2. Push the LFD button. The HMI prompts you to do the calibration.

3. Push the Yes button. The HMI prompts you regarding the number of burnt lamps (0 - 99).

4. Select '0', no broken lamps.

5. Wait until the equipment shows the Main screen. See Display overview: Main screen
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Remove lamps

1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Earth the series circuit

• With the SCO. See Use Series CutOut (SCO)

• With an earthing wire on the SCB

3. Remove the desired number of lamps in the field.

Note
Choose the number of lamps in function of the alarm level you use. By default, 8 to 10 lamps.

4. Switch ON the equipment and set it to LOCAL mode. See Operation.

Set number of removed lamps

1. On the HMI, push the Options button to go to the Options menu.

2. Push the LFD button. The HMI prompts you to do the calibration.

3. Push the Yes button. The HMI prompts you regarding the number of burn lamps (0 - 99).

4. Enter the number of removed lamps.

5. Wait until the equipment shows the Main screen. See Display overview: Main screen.

Examine the LFD measurement

1. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

2. Connect a number of lamps, but not all.

3. Switch ON the equipment and set it to LOCAL mode. See Operation.

4. Make sure that the number of lamps removed corresponds to the LFD reading on the main menu.

5. Make sure that all power to the equipment is OFF. See Switch OFF the power supply.

6. Leave the equipment OFF for 10 seconds.

7. Repeat the previous steps and connect the rest of the lamps.

Set alarm level

• With the configuration software tool, set the LFD Level1 and LFD Level2 alarm levels. See EFD/LFD screen.

5.3 Remote control configuration: multiwire (option)

Examine if the equipment is set to multiwire remote control

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Make sure that the remote control mode is ‘MULTIWIRE’.

6. If necessary, adjust the remote control mode.
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Examine or adjust the input and output signals function assigned to terminals

1. Push the → or ← buttons until the HMI shows the multiwire configuration.

2. Check and adjust the signals if necessary. See Maintenance menu.

Note
For the standard multiwire configuration, see Remote Control PCB.
You can only adjust the signals 6 to 15. The other signals are fixed.

5.4 Remote control configuration: J-Bus (option)

Configure the slave number

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the SLVNUM button to set the slave number of the equipment.

4. Push the SAVE button to save the slave number to the equipment.

Examine and adjust the configuration, if necessary

1. On the HMI, push the ESC button a number of times until the UI shows the Main menu.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Set the remote control mode to ‘JBUS’.

6. Set the applicable J-Bus protocol. The default value is ‘MCR2’.

7. Set the J-Bus mode to ‘485’.

5.5 Remote control configuration: ethernet (option)

Examine the remote control mode and adjust if necessary

1. On the HMI, push the MENU button to show the Main menu. See Display overview: Main screen.

2. Push the MAINT button to go to the Maintenance menu. See Maintenance menu.

3. Push the MORE button.

4. Push the → or ← buttons until the HMI shows the remote control mode.

5. Set the remote control mode to ‘JBUS’.

6. Set the applicable J-Bus protocol. The default value is ‘MCR2’.

7. Set the J-Bus mode to ‘Ethernet’.

Examine the ethernet configuration and adjust if necessary

1. Push the → or ← buttons until the HMI shows the ethernet configuration.

2. Examine the parameters and adjust if necessary.

3. If you use a double ethernet connection, push the DOWN button until the HMI shows the ethernet configuration of the
second ethernet connection.

4. Examine the parameters and adjust if necessary.
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6.0 Operation

6.1 Switch ON the equipment

When you switch ON the equipment, it starts to produce the same output current that was valid before the equipment was
switched OFF.

To set a different output current, select another brightness step. See Select brightness step. For more information on the
produced output currents, see Used brightness steps.

A prerequisite for this procedure is that the equipment is switched off.

1. Set the manual switch (A) to the ON position.

• The equipment starts to produce the same output current that was valid before the equipment was switched OFF

• The HMI lights up

• The equipment starts in the same mode as it was stopped: Local or Remote mode

WARNING
High voltage can be present on the system.

2. If the UI shows that the equipment is in the state OFF, push the ON button. The HMI shows the state ON.

3. To switch between Local and Remote mode, see Switch between local and remote mode.
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6.2 Switch OFF the equipment

1. On the HMI, push the Local button. The screen now shows the state LOCAL.

2. Push the OFF button. The equipment goes to the mode OFF.

3. Switch OFF the power supply. See Switch OFF the power supply.

6.3 Switch OFF the power supply

1. Set the manual switch (A) to the OFF position.

2. Open the main switch on the main distribution board.

3. Disconnect the equipment from the series circuit.

6.4 Switch between local and remote mode

To control the equipment through the HMI, switch to the local mode.

To control the equipment with the remote control system, switch to the remote mode.

1. For Local mode, push the LOCAL button on the HMI. The HMI now shows the mode LOCAL.
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Note
The keypad keys on the HMI only operate when the equipment is in Local mode.

2. For Remote mode, push the REMOTE button on the HMI. The UI now shows the mode REMOTE. You can change the
brightness step with the remote control device.

6.5 Select brightness step

1. Make sure that the equipment is powered ON, is in the ON state and in Local mode. See Operation.

2. To select a brightness step, push the corresponding number on the keypad. The equipment immediately starts to produce
the chosen brightness.

6.6 Adjust number of used brightness steps

1. Use the configuration software tool. See Output/Mains screen. For information on the used brightness steps, see Used
brightness steps.

2. Examine all brightness steps one by one. See Select brightness step . Examine if all light fittings have the same brilliancy
level. Go to the runway area to make a visual inspection.

6.7 Alarms

The HMI only shows information about errors that the equipment can detect. The equipment does not detect all possible
errors. You have to observe if the equipment operates correctly.

UM-6007, Rev. 2.2, 2024/07/17 63
Copyright © ADB Safegate, All Rights Reserved



Local mode

An alarm occurs, the equipment switches OFF automatically.

• If you need to switch off the power supply to remove the cause of the alarm: The equipment starts to produce the same
output current that was valid before the equipment was switched OFF.

• If you do not need to switch off the power supply to remove the cause of the alarm: The equipment remains in the state
OFF. Only after you reset the alarm and push the ON button, does the equipment start to produce the same output
current that was valid before the equipment was switched OFF.

Remote mode

An alarm occurs, the equipment switches OFF automatically.

• If you need to switch off the power supply to remove the cause of the alarm: The equipment starts at the actual
multiwire/J-Bus command.

• If you do not need to switch off the power supply to remove the cause of the alarm: After you reset the alarm, the
equipment automatically goes to the actual multiwire command.

Reset an alarm

1. If the HMI does not show the alarm, push the Menu button to go to the Main Menu.

2. To go to the Alarms menu push the Alarms button.

3. To reset the alarm push the Reset button.

Clear the error list

1. On the HMI, push the Menu button to go to the Main Menu.

2. Push the Alarms button to go to the Alarms menu.

3. Push the Clear alarms button. The equipment clears the error list.

6.8 Use Series CutOut (SCO)

6.8.1 Operation mode

WARNING
Always wear protective gloves and shoes when working with the equipment or series circuit.
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The SCO has three operation modes:

Description Mode A Mode B Mode C

Purpose Normal operation
Equipment delivers current to the
connected series circuit

Maintenance operation
Equipment or series circuit can be
serviced safely

Measurement possible The series
circuit insulation relative to ground
can be measured

Diagram

Cover placement 1

Handle position Horizontal Turned 90 degrees counter clockwise
from position A

Turned 90 degrees clockwise from
position A

Series circuit Connected to the equipment Shorted and grounded Disconnected from equipment,
shorted and connected to
measurement terminal

Equipment Delivers current to the series circuit Shorted and grounded Shorted and grounded

Microswitch 2 Activated. Equipment is ON Not activated. Equipment is OFF Activated. Equipment is ON

Notes
1 Only the three positions shown can be used. In another position, the cover fits correctly.
2 When the cover is closed, the micro switch is activated. When the cover is open, the microcircuit is deactivated and the equipment shuts down.

6.8.2 Adjust operation mode

Remove the cover

1. Open the lock (A).

2. Remove the cover (B). Use the handle.
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Set operation mode

1. Install the cover (B). See the cover placement in Operation mode.

2. Close the lock (A).

6.9 Operation mode

A series circuit with non-linear loads can be unstable. If the system is unstable, follow the procedure below.

Note
The equipment automatically detects if the inductive mode is required. The alarm message 'DC BUS VOLTAGE TOO
HIGH' means that the series circuit is unstable.

1. On the HMI, push the MENU button to go to the Main menu.

2. Push the OPTIONS button to go to the Options menu.

3. Push the MODE button to go to the Mode menu.

4. Select the applicable mode: Normal is the factory default. Inductive is for cases where the current regulation is under the
influence of inductive load and becomes unstable. The HMI now shows the Main screen.

Note
The equipment has these limitations in inductive mode:

• The power is limited to 85%

• The LFD measurement is not active

• In normal mode the equipment limits all current peaks higher than 7 A in less than 10 ms, in inductive mode the
current peak can reach 9 A

• The output waveform is not a perfect sinusoidal wave.
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7.0 Troubleshooting

WARNING
Do not troubleshoot unless you have read and understood all the information in the chapter Safety and you are
qualified to work on high-voltage systems.

• Set the equipment to Local mode

• Set the equipment to the brightness step OFF before you examine the series circuit

• Turn Off the main switch of the equipment

If you do not follow the steps above, an increase of the power input can start an on cycling and restart the equipment.
This results in a possible lethal output voltage.

7.1 Preliminary checks

Before you do any adjustments on the equipment, check:

• the alarm and back-indication signals on the display and/or remote control

• if the power supply to the equipment is within the acceptance limit

• if the fused input switches and auxiliary fuses are operational

• if the input fuses and auxiliary fuses work normally

• if all connectors are correctly in place

• that no components show burned marks.

• if the input circuit breaker is in the ‘open’ position

• wires are not interrupted or damaged.

7.2 Troubleshooting guide

Note
For a list of errors, see CCR status screen.
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7.2.1 Fault: Equipment does not turn ON

Table 9: Equipment does not turn ON
Problem Possible cause Possible solution

No display indications A problem with the power supply on the
diode bridge PCB

• Examine the transformer on the diode bridge

• If necessary, replace the IGBT power bridge that contains the
diode bridge PCB

See Diode bridge + sensing PCB (EPS476 / EPS507) replacement,
small and stackable cabinet

• Examine the external 400 VAC/24VAC transformer

• Replace the external transformer, if necessary

The main switch is damaged Replace the main switch. See Manual switch replacement

The input line filter is damaged Replace the line filter. See Line filter replacement

The main contactor is damaged Replace the main contactor. See Main contactor replacement,
small cabinet or Main contactor replacement, big cabinet

Replace the power supply PCB. See Power supply PCB (EPS480)
replacement

Replace the CPU PCB. See CPU PCB (EPS479) replacement
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7.2.2 Fault: Equipment does not go to the ON state

Table 10: Equipment does not turn ON
Problem Possible cause Possible solution

Local mode:

• The display shows an alarm

• The red lamp on top of the
equipment goes on

Remote mode:

• The red lamp on top of the
equipment goes on

One of the panels is open Close the panel

• Examine the fuses on power supply PCB

• Replace the fuses if necessary.
See Fuses on the power supply PCB (EPS480) replacement

• Examine the CPU PCB

• Replace the CPU PCB if necessary
See CPU PCB (EPS479) replacement

The main contactor is enabled when
the equipment is in the OFF state when
there is no command from the CPU
PCB. Or
The main contactor is not enabled
when there is a command from the
CPU PCB

• Examine the main contactor

• Replace the main contactor if necessary
See Main contactor replacement, small cabinet or Main
contactor replacement, big cabinet

Examine the wiring connections

• Examine the CPU PCB

• Replace the CPU PCB if necessary
See CPU PCB (EPS479) replacement

One or more phases is not present • Examine the fuses on power supply PCB

• Replace the fuses if necessary
See Fuses on the power supply PCB (EPS480) replacement

• Examine the external 400 VAC/24VAC transformer

• Replace the external transformer, if necessary

One of the fuses for the phases is
broken

• Examine the main fuses

• Replace the broken fuse. See Main fuses replacement

The main DC (560V) is too low or not
present.

• Examine the diode bridge

• Replace the diode bridge PCB if necessary
See Diode bridge and sensing PCB (EPS540 / EPS 541)
replacement, small cabinet or Diode bridge and sensing
PCB (EPS 497) replacement, big cabinet
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7.2.3 Fault: Equipment turns ON but suddenly de-energizes

Table 11: Equipment turns ON but suddenly de-energizes
Problem Possible cause Solution (See)

After you press the ON button,
record these problems:
Local mode:

• The display shows an alarm

• The red lamp on top of the
equipment goes on

Remote mode:

• The red lamp on top of the
equipment goes on

The input AC line delivers less than 360
VAC

Examine the input VAC line

• Examine the external 400 VAC/24VAC transformer

• Replace the external transformer, if necessary

Open circuit Examine the connection of the high voltage cable to the field
connection unit and to the power supply transformer

• Examine the output measure PCB.

• Replace the output measure PCB, if necessary. See Output
measure PCB (EPS442) replacement

Overcurrent • Examine the output measure PCB

• Replace the output measure PCB, if necessary. See Output
measure PCB (EPS442) replacement

A malfunction of the communication of
the output measurement PCB

The current on the primary winding of
the power supply transformer is too
high

• Examine the IGBTs

• If necessary, replace the IGBT power bridge that contains
the IGBT. See IGBT replacement, small cabinetor IGBT
replacement, big cabinet

• Examine the CPU PCB

• Replace the CPU PCB if necessary

See CPU PCB (EPS479) replacement

• Examine the IGBT PCB

• If necessary, replace the IGBT power bridge that contains
the IGBT PCB. See IGBT replacement, small cabinet or IGBT
replacement, big cabinet

7.2.4 Fault: equipment does not produce requested output current

Table 12: Equipment does not produce the requested output current
Problem Possible cause Solution (See)

The red lamp on top of the
equipment goes on

The equipment does not operate
correctly

• Examine the IGBT modules

• If necessary, replace the IGBT power bridge that contains the
IGBT module
See IGBT replacement, small cabinet or IGBT replacement, big
cabinet

• Examine the output measure PCB

• Replace the output measure PCB, if necessary. See Output
measure PCB (EPS442) replacement

• Examine the IGBT PCB

• If necessary, replace the IGBT power bridge that contains
the IGBT PCB. See IGBT replacement, small cabinet or IGBT
replacement, big cabinet
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7.3 Checks and measurements

7.3.1 Measure input voltage

1. Make sure that the main switch is OFF.

2. Make sure that the input supply cables that come from the mains distribution panel are only connected to the equipment
you want to measure.

3. Switch on the mains distribution to feed the equipment you want to measure.

4. Make sure that all connectors are securely tightened.

5. Measure the input voltage (V) to the equipment. Use a True RMS Multimeter.

6. Check the nameplate of the equipment and make sure that the input voltage is compatible with the equipment.

7.3.2 Measure output current
1. Make sure that main switch is OFF.

2. Install a calibrated True RMS multimeter with a current clamp in the output circuit.

3. Switch on the equipment and set the equipment to the highest brightness step. See Select brightness step.

4. Read the output current from the True RMS multimeter.

5. Make sure that the measurement is accurate. Calibrate the output current again if necessary.

7.3.3 Check fuse breaker and voltage of switch board
1. Make sure that the main switch is OFF.

2. Check the nameplate of the equipment to make sure that the fuse breaker voltage and the current rating of the
switchboard is compatible with the equipment. Allowed variance by standards:

• IEC: +10%

• FAA: ±10%

3. Set the main switch to ON.

4. Measure the voltage (V) of the switchboard. Use a calibrated True RMS multimeter.

7.3.4 Calculate minimum insulation resistance of series circuit
1. Calculate the minimum insulation resistance of the series circuit. See Calculate minimum insulation resistance of series

circuit.

2. Make sure that the calculated values are higher than the values measured during commissioning.

7.3.5 Calculate resistance of series circuit
1. Calculate the resistance of the series circuit. See Calculate resistance of series circuit.

2. Make sure that the calculated values are higher than the values measured during commissioning.

7.3.6 Measure cable capacitance
Measure the cable capacitance towards the ground as follows:

1. Make sure that the main switch is OFF.

2. Connect a multimeter to the regulator output cable. Use a Multimeter that has an internal resistance of 10 MOhm.

3. Disconnect the 500 V DC power cable to the EFD module. The Multimeter now measures the discharge time of the cable
capacitance from 400 V DC to 147 V DC.

If the cable capacitance is 1 pF, the measured voltage decreases from 400 V DC to 147 V DC (=0.37x400) in approximately 10
seconds.
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If the voltage you measure with the LFD module connected is already 330 V DC, the cable leakage resistance is approximately
10 MOhm. In this case, the discharge time is approximately 5 seconds for a cable capacitance of 1 pF.
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8.0 Maintenance

WARNING
• Only personnel authorized to work on high-voltage equipment can do maintenance work on the equipment.

• Operate the equipment under local control when you do maintenance work on the equipment to prevent the
equipment from being accidentally switched ON.

• Follow all local safety procedures.

• Make sure that you have obtained the necessary permissions according to the local operation procedures and
procedures regarding HV equipment.

8.1 Preventive maintenance schedule

Table 13: Preventive maintenance schedule
Frequency Check Action

In accordance with ICAO Aerodrome
Design Manual Part 9 Airport
Maintenance practices or in
accordance with local maintenance
regulations. Adapt the maintenance
frequency to the local conditions

Examine the operation of the
equipment on all brightness steps
on all readings

Use a PC to log the data, if required

Input voltage If the input voltage is not within the limits, tell the power
company to adjust the voltage. Make sure that you do the
necessary actions to align the input voltage with the input
limitations

Output current. Use a calibrated
True RMS multimeter and/or a
current clamp.

If the output current is not within tolerance, calibrate the
output current again

Visually:

• that the wiring of the equipment
and the circuit is not damaged

• for rust spots and general
damage

• the housing for dust
accumulation

• all signs on the equipment for
legibility and damage

• Repair damaged or loose wires

• Replace damaged components

• Clean and repair rust spots

• Clean the inside of the equipment with an dry air blower

If the electrical connections
(e.g. input connections, output
connections) are tightened correctly

Make sure that all connections are tightened

8.2 Part replacement

WARNING
• Make sure you have read and understood all safety procedures and standards related to this equipment. See

Safety.

• Make sure you switch OFF the power to the equipment. See Switch OFF the power supply.

• Make sure you switch OFF the manual switch to remove all power to the equipment.
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CAUTION
While you carry out maintenance:

• Do not drop screws or nuts inside the equipment cabinet. Collect loose nuts and screws immediately.

• To identify all cables you disconnect, label the cables.

• Make sure that you change the correct PCB.

• You have saved the equipment settings as a profile. To do this in the configuration software tool, see Install and
operate the configuration software tool.

• Put in the new parts exactly the same way as the parts you removed.

• After you replace a part, test the equipment to make sure it is replaced correctly.

Note
Refer to the electrical schemes inside the equipment cabinet for the connection schemes.

8.2.1 Required tools

Measurement tools

• True RMS Multimeter

CAUTION
The output voltage of the 30 kVA / 6.6 A equipment can reach approximately 4600 V at full load. An isolating
measurement transformer for use on the 5000 V AC line is recommended.

• Multimeter

• Insulation tester "Megger" 500 V or 1000 V

• Clamp or A-meter true RMS scale 10 and 30 A

CAUTION
The current regulation is +/- 1%. To make an acceptable readjustment of the output current, the accuracy of the
meter must be better than 0.5% for the adjusted value.

Other tools

• Standard electrical and mechanical tool kit

• Screwdrivers with protection up to 1000 V

• Spanner set (ring or socket spanners)

• Allen keys 4 and 6 mm

• Torque screwdrivers (2 - 10 Nm) and adaptors

• Short, slotted screwdriver

• Magnet rod for collecting loose items

• Angle socket wrench
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8.2.2 CPU PCB (EPS479) replacement

CAUTION
If you install an OVP version of the CPU PCB, make sure that the diode bridge PCB is also an OVP version.
If you install a non-OVP version of the CPU PCB, make sure that the diode bridge PCB is also a non-OVP version.
Make sure that you update the correct firmware. The firmware code for an OVP version of the PCB ends with an 'e'.

For parts, see Parts list.

• CPU PCB

• Firmware

Remove panel

• Remove the front panel. See Remove panels.

Disconnect

1. Disconnect the connectors and the wires (A).

2. Remove the fasteners (B).

3. Remove the CPU PCB (C).
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Install

1. Install the new CPU PCB.

2. Install the fasteners.

3. Connect all the wires.

CAUTION
Connect the keyboard cable with the green side down.

Update the firmware

1. Update the firmware. See Firmware update.

2. Install the front panel. See Remove panels.

8.2.3 Diode bridge and sensing PCB (EPS540 / EPS 541) replacement, small cabinet
For parts, see Parts list.

• Diode bridge + sensing PCB

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together constitute the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
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Prepare

1. Remove the front panel by way of preparation. See Remove panels.

2. Remove the precharge PCB. See Precharge PCB (EPS546) replacement, small cabinet.

Remove

1. Disconnect the wires and connectors (A).

2. Remove the fasteners (B).

3. Remove the diode bridge and sensing PCB (C).

Install

1. Wipe the copper plate (A) clean.

2. Apply an even layer of conductive paste on the copper plate.

3. Install the new diode bridge on the new diode bridge and sensing PCB.

4. Make sure that the diode bridge makes good contact with the heatsink.

CAUTION
If there is a washer or a screw between the diode bridge and the heatsink, the heat dissipation is not sufficient.

5. Connect the wires.

CAUTION
Carefully put the wire (B) through the sensing transformer (C). The sensing transformer is easily damaged.

6. Tighten the fasteners (B). Apply a torque of 2 Nm.

7. Install the precharge PCB. See Precharge PCB (EPS546) replacement, small cabinet.

8. Install the front panel. See Remove panels.
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8.2.4 Diode bridge and sensing PCB (EPS 497) replacement, big cabinet
For parts, see Parts list.

• Diode bridge + sensing PCB

Prepare

1. Remove the lower front panel. See Remove panels.

2. Remove the precharge PCB. See Precharge PCB (EPS546) replacement, small cabinet.

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.

Remove diode bridge

1. Remove the fasteners (A).

2. Disconnect the wires (B).

3. Remove the fasteners (C).

4. Remove the diode bridge (D).
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Install - 1

1. Wipe the heat sink clean, where you install the new diode bridge.

2. Apply an even layer of conductive paste on the back side of the new diode bridge.

3. Install the new diode bridge.

4. Make sure that the diode bridge makes good contact with the heatsink.

CAUTION
If there is a washer or a screw between the diode bridge and the heatsink, the heat dissipation is not sufficient.

5. Tighten the fasteners (A). Apply a torque of 4 Nm.

6. Install the new sensing PCB.

7. Connect all the wires to the new diode bridge PCB.

8. Tighten the fasteners (B).

Install - 2

1. Install the precharge PCB. See Precharge PCB (EPS456) replacement, big cabinet

2. Install the lower front panel. See Generic panels.

8.2.5 Display and keyboard replacement
For parts, see Parts list.

• Display/keyboard panel

1. Remove the display/keyboard panel. See Remove panels.

2. Install the new display/keyboard panel. See Remove panels.

8.2.6 Fuses on the power supply PCB (EPS480) replacement
For parts, see Parts list.

• Fuses. See also Protection devices.

1. Remove the lower front panel. See Remove panels.

2. To replace, push, turn counterclockwise and remove the fuse (A). If only one fuse is broken, replace only the broken fuse.

3. Install the new fuse.

4. Install the lower front panel. See Remove panels.
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8.2.7 IGBT PCB (EPS477 / EPS 478) replacement, small cabinet
For parts, see Parts list.

• IGBT PCB

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
The illustrations for this procedure show the situation for the 2.5 kVA and 10 kVA cabinets.

Remove panel

• Remove the front panel. See Remove panels.

Disconnect

1. Make sure that spring number 7 (A) of the IGBT is removed.

Once a spring is removed, it cannot be installed again.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the IGBT PCB (C).

Install

CAUTION
When you tighten the fasteners, only apply force vertically. Use an allen key screwdriver or an allen key handle instead
of a socket wrench or a ratchet. Sideways force can cause the components to get damaged.
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1. Make sure that spring number 7 (A) of the IGBT is removed. Once a spring has been removed, it cannot be reinstalled

2. Install the new IGBT PCB.

3. Connect all the wires.

4. Install the front panel. See Remove panels.

8.2.8 IGBT PCB (EPS496) replacement, big cabinet
For parts, see Parts list.

• IGBT PCB

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
The procedure shows the IGBT PCB at the right-hand side. The procedure for the IGBT PCB at the left-hand side is
similar.

Remove panel

• Remove the lower front panel. See Remove panels.

Remove

1. Disconnect the wires (A).

2. Remove the fasteners (B).

3. Remove the capacitors (C).

4. Remove the fasteners (D).

5. Remove the IGBT PCB.
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Remove the spring from the IGBT

• Make sure that spring number 7 (A) of the IGBT is removed. Once a spring has been removed, it cannot be reinstalled.

Install

CAUTION
When you tighten the fasteners, only apply force vertically. Use an alien key screwdriver or an allen key handle instead
of a socket wrench or a ratchet. Sideways force can cause the components to get damaged.

1. Install the new IGBT PCB (A) on the IGBT.

2. Install the fasteners (B) crosswise. Apply a torque of 4 Nm.

3. Install the capacitors (C).

4. Install the fasteners (D). Apply a torque of 4 Nm.

5. Connect the wires (E).

8.2.9 IGBT replacement, small cabinet
For parts, see Parts list.

• IGBT

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT power bridge. If one
component breaks, replace the entire IGBT power bridge.
The illustrations for this procedure show the situation for the 2.5 kVA and 10 kVA cabinets.
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Remove panel

• Remove the front panel. See Remove panels.

Remove 1

1. Remove the fasteners (A).

2. Remove the capacitor plate (B).

3. Remove the IGBT PCB. See IGBT PCB (EPS477 / EPS 478) replacement, small cabinet.

Remove 2

1. Disconnect the wire (A).

2. Remove the fasteners (B).

3. Remove the IGBT (C).
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Install 1

1. Wipe clean the heat sink below the IGBT (A).

2. Apply an even layer of conductive paste on the rear of the IGBT (the side that touches the heat sink).

3. Tighten the fasteners (B) crosswise. Apply a torque of 4 Nm.

Install 2

1. Install the IGBT PCB. See IGBT PCB (EPS477 / EPS 478) replacement, small cabinet.

2. Install the capacitor plate.

3. Connect the wires.

4. Install the fasteners (A). Apply a torque of 4 Nm.

5. Install the front panel. See Remove panels.

8.2.10 IGBT replacement, big cabinet

Note
The IGBT PCB, IGBT and the diode bridge and sensing PCB together are the IGBT power bridge. If one component
breaks, replace the entire IGBT power bridge.

1. Remove the IGBT PCB. See IGBT PCB (EPS496) replacement, big cabinet.

2. With a new IGBT, install the IGBT PCB. See IGBT PCB (EPS496) replacement, big cabinet.

8.2.11 Lightning arrestors replacement, equipment with SCO or SCB
For parts, see Parts list.

• Lightning arrestors

Note
The number of lightning arrestors can be different from the illustrations, depending on the output power.
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1. Remove the side panels. See Remove panels.

2. Disconnect the wires (A).

3. Remove the fasteners (B).

4. Remove the lightning arrestors assembly (C).

5. Install the new lightning arrestors assembly.

6. Install the wires.

7. Install the side panels. See Remove panels.

8.2.12 Line filter replacement
For parts, see Parts list.

• Line filter

1. Remove the side panels. See Remove panels.

2. Remove the lower rear panel. See Remove panels.

3. Disconnect the wires (A).

4. Remove the fasteners (B).

5. Remove the line filter (C).

6. Install the new line filter.

7. Install the wires.

8. Install the lower rear panel. See Remove panels.

9. Install the side panels. See Remove panels.
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8.2.13 Main contactor replacement
For parts, see Remove panels.

• Main contactor

WARNING
Make sure that you switched OFF the power to the equipment. See Switch OFF the power supply.

WARNING
Make sure that you switched OFF the external disconnection device to remove all power to the equipment.

Remove panel

• Remove the lower front panel. See Remove panels.

:

Disconnect

1. Loosen the screws (A).

2. Disconnect the wires (B).

3. Remove the main contactor (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new main contactor.

2. Connect all the wires.

3. Tighten the screws (A). Apply a torque of 4 (big cabinet) or 5 (small cabinet) Nm.

4.

Install the lower front panel. See Remove panels.
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8.2.14 Main fuses replacement
For parts, see Parts list.

• Fuses. See also Protection devices.

1. Remove the lower front panel. See Remove panels.

2. Open the fuse holder (A).

3. Replace the fuse (B).

4. Close the fuse holder.

5. Install the lower front panel. See Remove panels.

8.2.15 Manual switch replacement
For parts, see Remove panels.

• Manual switch

WARNING
Make sure you switch OFF the power to the equipment. See Switch OFF the power supply.

Note
Make sure you switch OFF the external disconnection device to remove al power to the equipment.
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Remove panel

• Remove the lower front panel. See Remove panels.

Disconnect

1. Loosen the screws (A).

2. Disconnect the wires (B).

3. Remove the manual switch (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new manual switch.

2. Connect all the wires.

3. Tighten the screws (A). Apply a torque of 4 Nm.

4. Install the lower front panel. See Remove panels.
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8.2.16 Output filter replacement, small cabinet
For parts, see Remove panels.

• Input filter

• Output filter

Note
.

• The number of filters and capacities can be different from the illustrations, depending on the output power.

• Always replace the input filter and the output filter together.

• For equipments up to 7.5 kVA, the output filter is not installed on a plate, but directly on the housing. In this case,
replace all individiual filter parts.

Remove panel

• Remove the side panels. See Remove panels.

:
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Remove

1. Disconnect the wires (A).

2. Remove the fasteners (B).

3. Remove the output filter plate (C).

Disconnect

1. Disconnect the fasteners (A).

2. Remove the output filter plate (C) from the back plate (B).

Install

1. Install the new output filter plate.

2. Connect the wires.

3. Tighten the fasteners (A). Apply a torque of 6 Nm.

4. Install the side panels. See Remove panels.
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8.2.17 Output filter replacement, big cabinet
For parts, see Remove panels.

• Input filter

• Output filter

Note
• The number of filters and capacities can be different from the illustrations, depending on the output power.

• Always replace the input filter and the output filter together.

Remove panel

• Remove the side panels. See Remove panels.

Remove

1. Disconnect the wires (A).

2. Remove the fasteners (B).

3. Remove the output filter plate (C).

Install

1. Install the new output filter plate.

2. Install the wires.

3. Tighten the fasteners (A). Apply a torque of 6 Nm.

4. Install the side panels. See Remove panels.
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8.2.18 Output measure PCB (EPS442) replacement
Parts: see Parts list.

• Output measure PCB

Remove panels

1. Remove the upper rear panel. See Remove panels.

2. Remove the screws (A).

3. Remove the box panel (B).

Disconnect

1. Disconnect the wires and connectors (A).

2. Remove the fasteners (B).

3. Remove the output measure PCB (C).

Install

1. Install the new output measure PCB.

2. Install the wires and connectors.

3. Install the box panel.

4. Install the upper rear panel. See Remove panels.
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8.2.19 Power supply PCB (EPS480) replacement
For parts, see Parts list.

• Power supply PCB

1. Remove the front panel. See Remove panels.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the power supply PCB (C).

5. Install the new power supply PCB.

6. Connect all the wires.

7. Install the front panel. See Remove panels.

8.2.20 Precharge contactor replacement
For parts, see Remove panels.

• Precharge contactor

WARNING
Make sure you have switched OFF power to the equipment. See Switch OFF the power supply.
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Remove panel

• Remove the lower front panel. See Remove panels.

Disconnect

1. Loosen the screws (A).

2. Disconnect the wires (B).

3. Remove the precharge contactor (C). Use a screwdriver as a lever to release the manual switch from the rail (D).

Install

1. Install the new precharge contactor.

2. Connect all the wires.

3. Tighten the screws (A). Apply a torque of 4 (big cabinet) or 5 (small cabinet) Nm.

4. Install the lower front panel. See Remove panels.
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8.2.21 Precharge PCB (EPS546) replacement, small cabinet
For parts, see Remove panels.

• Precharge PCB

Remove panel

• Remove the lower front panel. See Remove panels.

Disconnect

1. Remove the fasteners (A).

2. Remove the precharge PCB (B).

3. Disconnect the connectors (C).

Install

1. Connect the connector.

2. Install the new precharge PCB.

3. Tighten the fasteners with a torque of 2 Nm.Install the front panel. See Remove panels.

8.2.22 Precharge PCB (EPS456) replacement, big cabinet

Remove panel

• Remove the lower front panel. See Generic panels.

Remove

1. Disconnect the connector (A).

2. Remove the fasteners (B).

3. Carefully remove the precharge PCB (C).
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4. Remove the fasteners (D).

5. Remove the electrical wires.

Install

1. Connect all the wires.

2. Tighten the fasteners (A). Apply a torque of 4 Nm.

3. Install the new precharge PCB.

4. Install the lower front panel. See Generic panels.

8.2.23 Remote control PCB (EPS495 or EP00051) replacement
For parts, see Parts list.

• Remote control PCB or remote control PCB SIN

Note
The procedure is similar for the replacement of the remote conrol PCB SIN.

1. Remove the upper rear panel. See Remove panels.

2. Disconnect the connectors and the wires (A).

3. Remove the fasteners (B).

4. Remove the remote control PCB (C).

5. [Only applicable to EPS495.] Set the dip-switches of the new remote control PCB. See Remote Control PCB.

6. Install the new remote control PCB.

7. Connect all the wires.
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CAUTION
Depending on the configuration of the equipment, other wires need to be connected. These can be different from
the illustration above.

8. Install the upper rear panel. See Remove panels.

8.2.24 Series Connection Box (SCB) replacement (option)
For parts, see Parts list.

• Series Connection Box (SCB)

Prepare

1. Switch OFF the power supply. See Switch OFF the power supply.

2. Make sure that the circuit is earthed.

Remove panel

1. Loosen the fasteners (A).

2. Remove the box panel (B).

Remove

1. Loosen the screws (A).

2. Disconnect the series circuit cables (B).

3. Disconnect the wires and connectors (C).

4. Loosen the screws (D).

5. Carefully remove the SCB (E).
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Install

1. Install the new SCB.

2. Put the series circuit cables through the stress-relief clamps.

3. Tighten the screws of the stress-relief clamps.

4. Install all the wires and connectors.

5. Install the box panel.

8.2.25 Series CutOut (SCO) replacement (option)
For parts, see Parts list.

• Series CutOut (SCO)

Prepare

1. Switch Off the power supply. See Switch OFF the power supply.

2. Make sure that the circuit is earthed.

3. Open the lock (A).

4. Remove the cover (B). Use the handle.
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Remove

1. Loosen the screws (A1).

2. Remove the series circuit cables from the earthing bar (A2).

3. Disconnect the series circuit cables (A).

4. Loosen the screws (B1).

5. Disconnect the output cables (B).

6. Loosen the screw (C1)

7. Disconnect the earthing wire (C).

8. Remove the bolts (D).

9. Remove the SCO.

UM-6007, Rev. 2.2, 2024/07/17 99
Copyright © ADB Safegate, All Rights Reserved



Connect the micro switch

1. Disconnect the cables to the micro switch (A).

2. Connect the cables to the micro switch (A) in the new SCO.

Install

1. Install the new SCO.

2. Install the bolts (D).

3. Connect the earthing wire (C). Use the screw connection (C1).

4. Connect the output cables (B).

5. Tighten the screws B1.

6. Connect the series circuit cables (A).

7. Tighten the screws (A1).

8. Connect the wires to the earthing bar (A2).

• Make the connection of the shield of the cable to the earthing bar.

• If there is no shield on the cable, connect a clamp to the outside of the cable.
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Finish

• Install the cover of the SCO (A).

8.3 Remove panels

The panels of the equipment can be removed for installation or maintenance procedures.

WARNING
• Do not operate the equipment with any of the panels removed

• Do not mix panels from different equipment

• Always connect the earthing wires before you install the panels

• The panels can be heavy, especially the side panels

• Do not change or lock the panel switches. A panel switch sees if a panel is installed or not.

Note
The panels differ in size and number of screws. The illustrations below show the principle.
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8.3.1 Remove the display / keyboard panel of the small cabinet

Disconnect HMI

1. Remove the front panel. See Generic panels.

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).

Remove panel

1. Remove the top panel. See Top panel (small cabinet) .

2. Remove the screws (A).

3. Carefully remove the panel (B).
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CAUTION
Take care not to damage cables and connectors.

8.3.2 Remove the display / keyboard panel of the big cabinet

Disconnect HMI

1. Remove the lower front panel. See Top panel (small cabinet).

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).

Remove panel

1. Remove the screws (A).

2. Carefully remove the panel (B).

UM-6007, Rev. 2.2, 2024/07/17 103
Copyright © ADB Safegate, All Rights Reserved



CAUTION
Take care not to damage cables and connectors.

8.3.3 Top panel (small cabinet)

Disconnect HMI

1. Remove the front panel. See Generic panels .

2. Disconnect the wires (A) to the HMI from the CPU PCB (B).

3. Disconnect the earthing wire (C).

Remove

1. Remove the screws (A).

2. Remove the top panel (B).

Disconnect wires

• Disconnect the green/yellow earthing wires. The wires have a fast-on connector.
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8.3.4 Generic panels

Remove panel

1. Set the manual switch to the Off position.

2. Remove the screws (A) from the bottom to the top.

WARNING
The panels are heavy. Also, the momentum of the panel can cause damage to the panel and the screws if you
remove the top screws first.

3. Carefully remove the panel (B).

CAUTION
Take care to not damage cables and connectors.

Disconnect wires

• Disconnect the green/yellow earthing wires. The wires have a fast-on connector.

8.4 Firmware update

Tools

• PC with serial port connection

• Firmware update dongle: ‘Pin to Pin DB9P & DB9S cable’

• Correct firmware upload file

Firmware update procedure

1. Install the software to upload the firmware. See Install the software to upload the firmware.

2. Change the SD flash file paths, if necessary. See Change the SD Flash file paths.
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3. Do a check on the equipment parameters. See Check equipment parameters.

4. Update the firmware. See Update the firmware.

5. Start the equipment after a firmware update. See Start the equipment after a firmware update.

8.4.1 Install the software to upload the firmware

Install the software

1. Unzip the file ‘sdflash.zip’ to the default path of D:\sdflash.

Note
If you extract the zip file to a different location, see Change the SD Flash file paths.

2. Run the program SDFlash.exe.

3. Select File > Open Project.

4. Select the ‘F2812SerialFlash.sdp’ project from the ‘sdflash’ directory.

5. If you opened the program for the fist time, select the correct Emulator Address/ID.

Note
This is the same process as selecting the correct COM-port address, where C4 would equal COM 4. Refer to the
device manager of the PC to find the correct address. You can change this setting later from the Project >Settings
>Target tab>Emulator Address/ID drop down list.

6. Go to File > Exit.

7. Click Save.

Check the port settings

1. Go to Start>Control Panel>System>Hardware tab>Device Manager>Ports>USB Serial Port.

2. Right-click on USB Serial Port.

3. Select Properties.

4. Select the tab Port Settings.

5. In the Advanced Settings for COM window, do as follows:

• Make sure that the COM Port Number is correct. Select the correct Emulator Address/ID (see earlier in this procedure)

• Change Receive (Bytes) to 4096

• Change Transmit (Bytes) to 4096

• Change Latency Timer (msec) to 16
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8.4.2 Change the SD Flash file paths

Note
Follow this procedure if you extracted the zip file 'sdflash.zip' to a different location than D:\sdflash.

1. Go to Project > Settings.

2. In the indicated tabs, change the indicated fields to the correct file path.

Tab Field

Target
Driver

Board File

Erase Algorithm

Programming Algorithm

Verify Algorithm

3. Click OK.

8.4.3 Check equipment parameters
1. Start the configuration software tool. See Start the configuration software tool.

2. Go to the Configuration screen.

3. Go to the Identification tab.

4. Push the Read button to show the firmware details.

5. Make sure that the equipment parameters below match those of the filename of the required firmware version:

• Single Phase (CRE) or Tri-phase (VIS)

• Input Voltage: 230V range or 400V range

• CCR Power Rating in kVA

• SHVS installed or SHVS not installed.

• The type of control system. This is PPT unless specified.

6. Stop the configuration software tool. See Stop the configuration software tool .

7. Switch OFF the equipment. See Switch OFF the equipment .

8. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply .
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8.4.4 Update the firmware

Prepare the equipment

1. Remove the lower front panel. See Generic panels

2. Remove the watch-dog jumper from the CPU PCB (EPS479). See CPU PCB (EPS479).

3. Connect the firmware update dongle (A) between the PC and the equipment.

4. Click on SDFlash.exe.

5. Do a check if F2812SerialFlash.sdp loads.

6. If not, see Install the software to upload the firmware and load the correct project.

7. Switch ON the equipment. See Operation. When the equipment is ready for the firmware upload, the HMI is blank.

8. If the HMI is not blank, see Install the software to upload the firmware and load the correct project.

Upload the firmware

1. Go to Project>Settings>Programming tab>Flash Data File field.

2. Select the correct firmware version file from the files with a *.out extension.

3. Go to Device>Flash. If asked to save changes, click yes.

4. Make sure that the Erase, Program and Verify check boxes are checked.

5. Click Start.

6. Wait until the upload is complete.

7. Close the SDFlash program.

8.4.5 Start the equipment after a firmware update

Start the equipment again

1. Switch OFF the equipment. See Switch OFF the equipment.

2. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

3. Install the watch-dog jumper on the CPU PCB.

4. Switch ON the equipment. See Operation.
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Check if the firmware is correctly updated

1. Make sure that the firmware data on the lower line of the main menu on the HMI is correct.

2. Start the configuration software tool. See Start the configuration software tool.

3. Go to the Configuration screen.

4. Go to the Identification tab.

5. Push the Read button to show the firmware details.

Disconnect the cable and install the front panel

1. Switch OFF the equipment. See Switch OFF the equipment.

2. Make sure that the manual switch is in the OFF position. See Switch OFF the power supply.

3. Disconnect the firmware update dongle.

4. Install the lower front panel. See Generic panels.

5. Switch ON the equipment. See Operation.
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9.0 PCB drawings and settings

9.1 CPU PCB (EPS479)

Figure 28: Printed Circuit Board (PCB)

9.1.1 LEDs

Table 14: CPU PCB LED functions
LED Color Function

LDX1 Red The voltage for the power supply is +5V DC (generated on the PCB)

LDX2 Red The voltage is +5V DC

LDX3 Red The voltage from the power supply PCB is +12 V DC

LDX4 Red The CPU operates

LD1 Green The voltage for the power supply on the PCB is +5 V DC (generated on the PCB)

LD2 Green The voltage for the power supply on the PCB is +3.3 V DC (generated on the PCB)

LD3 Green The voltage for the powers supply on the PCB is +1.8 V DC (generated on the PCB)
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9.2 Power supply PCB (EPS480)

Figure 29: Printed Circuit Board (PCB)

9.2.1 LEDs

Table 15: Power supply PCB LED functions
LED Color Function

LD1 Green The voltage for the fans, if applicable is +24 V DC (generated on the PCB)

LD2 Red The voltage of the power supply on the PCB is 12 V DC

LD3 Red The fan connected to J8 is active

LD4 Red The fan connected to J10 is active

LD5 Red The LED is red when the fan connected to J12 is active

LD6 Red The fan connected to J14 is active

LD7 Red The fan connected to J16 is active

LD8 Red The fan connected to J18 is active

LD9 Red The the input voltage after the diode bridge PT is 24 V DC (nominal)

LD10 Red The voltage of the power supply on the PCB is 20 V DC

LD11 Red The sense input line voltage is 24 V AC (nominal)

LD12 Green The voltage from the 50 kHz power supply on the PCB is 48 V DC

9.2.2 Fuses

Table 16: Power supply PCB Fuses
F1 1.6 A

F2 2.5 A
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9.3 Remote Control PCB

Note
Until 2022, the VIS was delivered with the EPS495 board as the remote control PCB. Since 2022, the VIS has been
delivered with the EP00047, and the EP00051 as an add-on board when Multiwire is required. The functionalities
of these boards are equivalent in most cases, with the exception of the most demanding recent ALCMS systems
with a redundant bus. For VIS units equipped with the EPS495, there are options to transition to the EP00047 (and
the EP00051 add-on if needed) when required. Please contact your ADB Safegate representative for more details if
needed.

9.3.1 EPS495 (1597.00.300)
Figure 30: Printed Circuit Board (PCB)

9.3.1.1 LEDs

Table 17: Remote control PCB LED functions
LED Color Function

LD1 Green The LED is green when the voltage of the power supply on the PCB is 12 V DC

LD2 Green The LED is green when the voltage from the DCDC1, generated on the PCB, is + 5 V DC insulated

LD3 Green The LED is green when the voltage from the DCDC2, generated on the PCB, is + 5 V DC insulated

LD4 Red The LED flashes red when the U5 CPU is active

lD5 Red The LED flashes red when the U6 CPU is active

9.3.1.2 Jumper settings

Table 18: Remote control PCB jumper settings
Jumper Position Function

JP2 insert enable TX serial channel 1 termination resistance

JP3 insert enable RX serial channel 1 termination resistance

JP4 insert enable TX serial channel 2 termination resistance

JP5 insert enable RX serial channel 2 termination resistance
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Table 18: Remote control PCB jumper settings (Continued)
Jumper Position Function

JP6 position 1-3 and position 2-4
1 3 5
2 4 6

ethernet channel 1: enable

position 3-5 and position 4-6
1 3 5
2 4 6

serial channel 1: enable

JP7 position 1-3 and position 2-4
1 3 5
2 4 6

ethernet channel 2: enable

position 3-5 and position 4-6
1 3 5
2 4 6

serial channel 2: enable

J15 position 2-3
3 2 1

serial channel 1: RS485 configuration

position 1-2
3 2 1

serial channel 1: RS422 configuration (not used)

Jumper Position Function

J16 position 2-3
1 2 3

serial channel 1: RS485 configuration

position 1-2
1 2 3

serial channel 1: RS422 configuration (not used)

J19 position 2-3
1
2
3

serial channel 2: RS485 configuration

position 1-2
1
2
3

serial channel 2: RS422 configuration (not used)

J20 position 2-3
1
2
3

serial channel 2: RS485 configuration

position 1-2
1
2
3

serial channel 2: RS422 configuration (not used)
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9.3.2 EP00047 and EP00051
Figure 31: Printed Circuit Board (PCB)

Bus A Bus B CAN μProc

J22 120 Ohm
RS485_2_TX+ (1-2)

J32 120 Ohm
RS485_1_TX+

J3 120 Ohm CAN (1-2) J16 Boot-GND (2-3)

J26 120 Ohm
RS485_2_RX+

J36 120 Ohm
RS485_1_RX+

J25 RS485_2_RX+ (4w:2-3,
2w:1-2)

J35 RS485_1_RX+
(4w:2-3)

J28 RS485_2_RX- (4w:2-3) J38 RS485_1_RX- (4w:2-3)

J14 RS485_2 (3-5, 4-6) J13 RS485_1 (3-5, 4-6)
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9.3.3 Multiwire/J-Bus connection scheme

Note
The table shows the standard remote control configuration for the signals. If you want another configuration, contact
ADB Safegate.

Table 19: Factory set terminal assignments for remote control connections with multiwire and single J-Bus (Cable Set
4072.30.XXX)
Function Terminal number on 32-pole connector Relay number on Remote Control PCB (unless

indicated otherwise)

Control signals (fixed)

Step 1 - CMD 1 J1.1

Step 2 - CMD 2 J1.2

Step 3 - CMD 3 J1.3

Step 4 - CMD 4 J1.4

Step 5 - CMD 5 J1.5

ON - CMD 6 J1.6

CCR OFF from HVCS - CMD 26 J1.7

NC NC J1.8

V-OUT 48V 15 J8.1

GND 48V 17 J8.2

CM – FB (general common relay return) 8 J8.3

CM – FB (general common relay return) 7, 18, J6.4 J8.4

24 CRE doorswitch (power input door)

26 CRE doorswitch (power input door)

7

Feedback signals (fixed)

Step 1 9 J5.1

Step 2 10 J5.2

Step 3 11 J5.3

Step 4 12 J5.4

Step 5 13 J5.5

ON (step1,2...5) / OFF (OFF or Standby
Step0)

19 J5.6
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Table 19: Factory set terminal assignments for remote control connections with multiwire and single J-Bus (Cable Set
4072.30.XXX)  (Continued)
Function Terminal number on 32-pole connector Relay number on Remote Control PCB (unless

indicated otherwise)

Feedback signals (configurable via HMI): the values below are default values, for configuration options (for the options, see the table that
follows)

Disable local/remote (relay 7 for both
connections)

14 J5.7 (NC relay)

28 J5.8 (NO relay)

Open circuit - FB 16 J6.1

Overcurrent - FB 20 J6.2

Bad regulation 22 J6.3

7, 18, J8.4 J6.4 (CM)

LFD alarm (Relay 11) 23 J6.5 (NO relay)

NC NC J6.6

EFD warning - FB 24 J6.7

EFD error - FB 25 J6.8

High temperature alarm - FB 27 J7.1

Short circuit - FB 29 J7.2

Lamp fault warning - FB 21 J7.3

(not used) NC J7.4

J-Bus interface (fixed)

RS485 Bus A GND 30 DB9.3

RS485 Bus A + 31 DB9.1

RS485 Bus A - 32 DB9.2

Table 20: Factory set terminal assignments for remote control connections with multiwire dual J-Bus (Cable Set
4072.30.182)
Function Terminal number on 32-pole

connector
Relay number on Remote Control PCB (unless
indicated otherwise

Control signals (fixed)

Step 1 - CMD 1 J1.1

Step 2 - CMD 2 J1.2

Step 3 - CMD 3 J1.3

Step 4 - CMD 4 J1.4

Step 5 - CMD 5 J1.5

ON - CMD 6 J1.6

CCR OFF from HVCS - CMD 7 J1.7

NC 8 J1.8

V-OUT 48V 25 J8.1

GND 48V 9 J8.2

Feedback signals (fixed)

GND - FB 10 J8.3

GND - FB NC J8.4
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Table 20: Factory set terminal assignments for remote control connections with multiwire dual J-Bus (Cable Set
4072.30.182) (Continued)
Function Terminal number on 32-pole

connector
Relay number on Remote Control PCB (unless
indicated otherwise

Step 1 - FB 11 J5.1

Step 2 - FB 12 J5.2

Step 3 - FB 13 J5.3

Step 4 - FB 14 J5.4

Step 5 - FB 15 J5.5

ON (step1,2...5) / OFF (OFF or Standby Step
0 - FB)

16 J5.6

Feedback signals (configurable via HMI):

Disable local/remote NC NC J5.7 (NC relay)

NC J5.8 (NO relay)

Open circuit - FB 17 J6.1

Overcurrent - FB 18 J6.2

Bad regulation 19 J6.3 (CM)

CM specific return for Relay 11 NC J6.4

LFD alarm (Relay 11) NC J6.5 (NO relay)

NC NC J6.6

EFD warning - FB 20 J6.7

EFD error - FB NC J6.8

High temperature alarm - FB NC J7.1

Short circuit - FB NC J7.2

Lamp fault warning - FB NC J7.3

(not used) NC J7.4

J-Bus interface (fixed)

RS485 Bus B GND 27 DB92.3

RS485 Bus B- 28 DB92.1

RS485 Data B+ 29 DB92.2

RS485 Bus A GND 30 DB9.3

RS485 Data A - 32 DB9.2

RS485 Data A + 31 DB9.1
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Figure 32: Multiwire and J-Bus connection

A Equipment

B Remote control equipment

C Remote control PCB - input signals

D Remote control connector on the equipment

E Opto coupler

F 48 V DC power supply

G Isoground

H +48 V DC I Rel com

J Remote control PCB - feedback signals

K Relays

L 24 V DC power supply

M J-Bus RS485 connection

N J-Bus RS485 interface

9.4 IGBT PCB (EPS477 / EPS 496)

Figure 33: Printed Circuit Board (PCB) EPS477 for2s Semix
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9.4.1 LEDs EPS477 for 2s Semix

Table 21: IGBT PCB LED functions
LED Color Function

LDX1 Red The voltage for the high side IGBT, generated on the PCB, is +18 V DC.

LDX2 Red The voltage for the high side IGBT, generated on the PCB, is -5 V DC.

LDX3 Red The voltage for the low side IGBT, generated on the PCB, is +18 V DC.

LDX4 Red The voltage for the low side IGBT, generated on the PCB, is -5 V DC.

9.4.2 Printed Circuit Board (PCB) EPS496 for 3s Semix

A LDX1 - red

B LDX2 – red

C LDX3 – red

D LDX4 – red

E LDX4 - red

9.4.3 LEDs EPS477 for 1s and 2s Semix

Table 22: IGBT PCB LED functions
LED Color Function

LDX1 Red The voltage for the high side IGBT, generated on the PCB, is +18 V DC.

LDX2 Red The voltage for the high side IGBT, generated on the PCB, is -5 V DC.

LDX3 Red The voltage for the low side IGBT, generated on the PCB, is +18 V DC.

LDX4 Red The voltage for the low side IGBT, generated on the PCB, is -5 V DC.

LDX5 Red The voltage for logic IC power supply is + 5 V DC.
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9.5 Output measure PCB (EPS442)

Figure 34: Printed Circuit Board (PCB)

9.5.1 LEDs

Table 23: Phase bridge PCB LED RUN light functions
LED Color Function

LD1 Red Flashes red when the CPU on the PCB is active.

9.6 Diode bridge and sensing PCB (EPS540 / EPS 541 / EPS 497)

Figure 35: Printed Circuit Board (PCB)

9.6.1 LEDs

Table 24: LEDs - Diode bridge and sensing PCB LED functions
LED Color Function

LDX1 Red The nominal voltage for the IGBT test is 24 V DC

LDX2 Red The voltage from the power supply PCB is +5 V DC

LDX3 Red The voltage from the 50 kHz power supply on the PCB is +18 V DC

LDX4 Red The nominal voltage for the IGTBT bridge bus is 560 V DC
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9.7 Test parameters

9.7.1 Analog channels

Table 25: Analog channels
Channel Description Value range

0 Temperature 17000 - 32000

1 Temperature 27000 - 32000

2 I bridge 100 - 2000

3 V bridge 0 - 30000

4 V in ±31000

5 Aux 1 x = 0

6 Aux 2 x = 0

Ref1 V reference 1 ± 54000

Ref2 V reference 2 ± 2800

9.7.2 Input

Table 26: Test input parameters
Connector Function

PB0 Fan 1

PB1 If 1, the Precharge control switch is enabled

PB2 If 1, the Main control switch is enabled

PB3 Fan 2

PB4 If 0, SCO/panel is open

PB5 If 1, BUS fuse is not damaged

PF0 If 0, the overcurrent protecion is ON

PF1 If 0, the overcurrent protecion is ON

9.7.3 Output

Table 27: Test output parameters
Connector Function

PE0 0 = Main control switch enabled

PE1 0 = Precharge control switch enabled

PE2 0 = Gate H activation

PE3 1 = Fan enabled

PE4 Display font

PE5 1 = Display back lighting ON

PE6 1 = Red fault LED ON

PE7 1 = Green power LED ON

9.7.4 External input
I0 to I15: Inputs from multiwire PCB.
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9.7.5 External output
O0 to O15: Outputs from multiwire PCB.

9.7.6 PIC analog channels

Table 28: PIC anaolg channels test
Channel Description

Div_I Number of divisions of output current

Div_V Number of divisions of output voltage

EFD Number of divisions of EFD

Phase Phase displacement between V and I (x 1000)
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10.0 Technical Data

Table 29: Technical Specifications
Item Description

Rated input voltage [V] 400 V AC (± 10%) single phase

Rated frequencies [Hz] 50 or 60

Current regulation limits Current regulation is guaranteed under the following conditions (± 0.1 A):

• Under IEC 61822:2009 environmental conditions

• For nominal input voltage under IEC or FAA standard conditions

• From full load to short circuit

Current regulation modes Two preset regulation modes:

• normal mode (for linear loads)

• inductive mode (for non-linear loads (e.g. LED loads)

Average efficiency at full load 92 to 94% depending on the size of the equipment, under nominal resistive load, nominal output
current, and nominal input voltage

Power factor at output The power factor exceeds the IEC and FAA requirements. The power factor at rated load is close to 1
and is kept at a high level for possible operational conditions

Brightness steps 5 standard, 8 maximum, fully adjustable in 65k levels (1mA resolution)

Output current [A] 6.6

Remote control and monitoring • Multiwire:

• Compatible voltage: for units without circuit selector; 24 VDC for units with circuit selector

• Internal power supply: 48 VDC for units without circuit selector; 24 VDC for units with circuit
selector

• Single or dual J-Bus protocol over RS485/RS422

• Single or dual J-Bus protocol over Ethernet IEEE 802.3

Regulation response time • Less than 0.5 seconds

• Exceeds the requirements of IEC 61822:2009

Open circuit ouput voltage Less than 1.2 times the nominal output voltage (RMS)

Ingress protection IP 21

Table 30: Output specifications
Type Rated output power

[kW]
RMS output voltage at 6.6 A
RMS output current [kV]

Insulated test on
output 1 [kV]

Output overvoltage protection
25kApk

VIS 2.5 2.5 0.38 3 0.75 kVRMS, 1.4 kJ

VIS 4.0 4.0 0.60 5 1.5 kVRMS, 2.8 kJ

VIS 5.0 5.0 0.75 5 1.5 kVRMS, 2.8 kJ

VIS 7.5 7.5 1.13 6 2.2 kVRMS, 4.2 kJ

VIS 10 10 1.50 10 2.2 kVRMS, 4.2 kJ

VIS 15 15 2.30 12 3.0 kVRMS, 5.6 kJ
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Table 30: Output specifications (Continued)
Type Rated output power

[kW]
RMS output voltage at 6.6 A
RMS output current [kV]

Insulated test on
output 1 [kV]

Output overvoltage protection
25kApk

VIS 20 20 3.00 15 4.5 kVRMS, 8.4 kJ

VIS 25 25 3.80 19 5.2 kVRMS, 9-8 kJ

VIS 30 30 4.54 23 6.0 kVRMS, 11.2 kJ

Notes
1 Test condition: 50 Hz sinosoidal wave for 1 minute. The test is done without output overvoltage protections.

10.1 Applicable standards

The equipment is in accordance with these standards:

Standard Description

ICAO Aerodrome Design Manual, Part 5 paragraphs 3.2. (current edition)

FAA 1 AC 150/5345-10 (current edition), L-828 and L-829 except for input voltage

IEC IEC 61822:2009

CENELEC EN 61822

CE certified

Notes
1 The equipment is not FAA equipment but it complies with most of the FAA requirements.

10.2 ElectroMagnetic Compatibility (EMC)

The equipment is designed to operate in an industrial electro-magnetic environment. The regulator complies with IEC
61822:2009, in accordance with IEC 61000-6-4 and IEC 6-6-2 (generic standard for industrial environment). The equipment is,
with adapted test levels, in accordance with IEC/TS61000-6-5, G (substation environment, location G).
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10.3 Dimensions and mass

Figure 36: The small cabinet (A) and the big cabinet (B)

Table 31: Dimensions
Item A - 2.5 kVA A - 4 to 15 kVA B - 20 to 30 kVA

X [mm] 420 420 520

Y [mm] 1 550 840 840

Z [mm] 1300 1300 1600

Notes
1 Depending on the output power connection (options)

Table 32: Mass
Type Net mass Crate mass Crate dimensions width x depth x height [mm]

2.5 140 23 1200 x 800 x 1500

4 180 23 1200 x 800 x 1500

5 190 23 1200 x 800 x 1500

7.5 215 23 1200 x 800 x 1500

10 255 23 1200 x 800 x 1500

15 285 23 1200 x 800 x 1500

20 360 40 1200 x 800 x 1850

25 410 40 1200 x 800 x 1850

30 450 40 1200 x 800 x 1850
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10.4 Protection devices

Table 33: Protection devices specifications
Equipment type
[kVA]

Equipment
voltage [V]

Main fuse rating [A] Manual switch type C rating [A] Maximum line input current [A]

2.5 380 to 400 16 10 5.9

4 16 16 9.4

5 16 16 11.7

7.5 20 20 17.6

10 50 40 23.4

15 50 40 35.2

20 80 80 46.9

25 80 80 58.6

30 100 100 70.3

10.5 Used brightness steps

All equipments are programmed with five steps by default. You can change the number of required steps. Table 34 shows the
current values that the equipment produces at each step, depending on how many steps are programmed.

Example:

The equipment is set to five brightness steps. The default current value set for step 3 is 4.1 A.

Table 34: Current values produced at each brightness step
Brightness
step

Default current value [A]

No. of steps used

3 4 5 (default) 6 7 8

1 4.8 3.3 2.8 2.7 2.2 2.8

2 5.5 4.4 3.4 3.4 2.8 3.1

3 6.6 5.5 4.1 3.9 3.4 3.4

4 6.6 5.2 4.5 4.1 3.9

5 6.6 5.4 5.2 4.6

6 6.6 6.4 5.5

7 6.6 6.4

8 6.6

These values apply when the minimum current is 2.8 A and the maximum current is 6.6 A.
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10.6 Ambient conditions

The equipment is air-cooled with fans. Thus, the equipment must have a good airflow, especially if they operate near the
maximum temperature.

Table 35: Ambient conditions
Item Description

Temperature From -20 up to +55 °C 1

Altitude From 0 (sea level) up to 1000 meter

Relative humidity From 10% up to 95% RH without condensation

Notes
1 For IEC conformity to -40 °C an optional modification is required.

10.7 Parts list

WARNING
Use only original ADB Safegate spare parts. If you use other spare parts, the specific module or the equipment may be
damaged. This can also put personnel in danger.

Note
The parts list may be subject to change without prior notice. Contact ADB Safegate to obtain the latest version.

Part orders

Each part of the equipment has a part number. When you order parts:

• Always mention the part number of the ordered part

• Always mention serial number and type of the equipment. These are indicated on the nameplate of the equipment.

For all spare part orders, contact ADB Safegate or the local representative of ADB Safegate.

Recommendations

To reduce downtime during maintenance, have one or more extra equipment cabinets in stand-by at the substation. This is
especially important at major airports, which have a large amount or equipments.

Keep spare parts always in stock. For example:

• Fuses

• Lightning arrestors

• PCBs

10.8 Preventive spare parts

Item Table

Main fuse Preventive spare parts

Main contactor Table 37

Lightning arrestors Table 38

Overvoltage protection Table 39

Capacitors Table 40
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Item Table

Safety switches Table 41

Fan Table 42

IGBT bridge Table 43

Micro control PCB Table 44

Output measure PCB Table 45

Power supply PCB Table 46

Remote control PCB Table 47

Diode bridge PCB Table 48

IGBT PCB Table 49

Precharge PCB Table 50

Ethernet adapter Table 51

Display and keyboard Table 52

Table 36: Preventive spare parts - Main fuse
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Fuse 16A 10X38 aM 6130.20.150 3 3 3

Fuse 20A 10X38 aM 6130.20.160 3

Fuse 50A 14x51 aM 6130.20.210 3 3

Fuse 80A 22x58 aM 6130.20.280 3 3

Fuse 100A 22x58 aM 6130.20.300 3

Table 37: Preventive spare parts - Main contactor
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Contactor LC1D12B7 6148.46.030 2

Contactor LC1D32B7 6148.46.000 2 2 2 2

Contactor LC1D40B7 6148.46.010 2 1 1 1

Contactor LC1D80B7 6148.46.020 1 1 1

Table 38: Preventive spare parts - Lightning arrestors
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Lightning arrestor SIOV
B72232-B751-K1

6314.32.750 2 4 4 4 6 8 10 12 14

Table 39: Preventive spare parts - Overvoltage protection
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Overvoltage protection
V480LA80BP

6314.12.286 1 1

Constant Current Regulator Type VIS
Technical Data

130
Copyright © ADB Safegate, All Rights Reserved



Table 40: Preventive spare parts - Capacitors
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

CAP. PPA1854100KN
polypropylene film +

6322.60.240 2 2 2 2

CAP. PMC1704500KVR
5uF/700V step 20-25+

6322.60.220 2 2 2 2 2

Table 41: Preventive spare parts - Safety switch
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Doorswitch EPS: 684 6150.49.060 3 3 3 3 3 3 4 4 4

Table 42: Preventive spare parts - Fan
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

CCR FAN 120x120x38
24vdc ball bearing

7074.10.100 2 6 6 6

CCR FAN connect.cable
(15kVA

6100.15.300 1

Table 43: Preventive spare parts - IGBT bridge
Description Part number Quantity per order

400 V 230 V

2.5 4 5 7.5 10 15 20 25 30 2.5 2.5 4 5 7.5

Semix 202 GB 12E4s 6351.88.040 2 2 2 2 2 2 2 2 2 2 2

Semix 453 GB 12E4s 6351.88.060 2 2 2

ISOLAT.M6 0.6kV 6126.12.485 2 2 2

Semix 341D16s 6351.88.030 1 1 1

Table 44: Preventive spare parts - CPU PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS479/5 CRE/VIS CPU pcb:CS00179
rev.1.1

1597.00.000 1 1 1 1

EPS479/15 CRE/VIS
CPU pcb:CS00179 rev1.1

1597.00.010 1 1

EPS479/30 CRE/VIS
CPU pcb:CS00179 rev1.1

1597.00.020 1 1 1
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Table 45: Preventive spare parts - Output measure PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS442/2.5 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.100 1

EPS442/5 CRE/VIS out.meas.board
CS0039
rev.2.2

1597.00.110 1 1

EPS442/7.5 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.120 1

EPS442/10 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.130 1

EPS442/15 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.140 1

EPS442/20 CRE/VIS
out.meas.board CS0039
rev.2.2

1597.00.150 1

EPS442/30 CRE/VIS
out.meas.board CS0039 rev.2.2

1597.00.160 1 1

Table 46: Preventive spare parts - Power supply PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS480/30 VIS pow.sup.board PCB
CS00180 rev.1.2 (6 fans, with
SHVS)

1597.00.230 1 1 1 1 1 1 1 1 1

Table 47: Preventive spare parts - Remote control PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS495 CRE/VIS communication
board PCB CS00190 rev.1.2

1597.00.300 1 1 1 1 1 1 1 1 1
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Table 48: Preventive spare parts - Diode bridge and sensing PCBT
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS540/7.5 VIS5000-08
PCB CS00228 rev.1.0
(diode bridge & sensing)

1597.00.441 1 1 1 1

EPS541 10/15
VIS5000-08 PCB CS00229 rev.1.0
(diode bridge & sensing)

1597.00.451 1 1

EPS497 CRE20/30 HAIS150-P
interface board.CS00192 rev.1.0
(sensing without diode bridge)

1597.00.500 1 1 1

EPS476/30 CRE/VIS 20/
30KVA PCB CS00176
rev.2.0 (sensing, without diode
bridge)

1597.00.421 1 1 1

Table 49: Preventive spare parts - IGBT PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS477 CRE/VIS 2.5/ 15KVA PCB
CS00177
rev.1.1 (IGBT driver)

1597.00.510 2 2 2 2 2 2

EPS478 CRE/VIS 2.5/ 15KVA PCB
CS00178
rev.1.0

1597.00.520 1 1 1 1 1 1

EPS496 CRE/VIS 20/ 30KVA PCB
CS00191
rev. 1.0

1597.00.530 2 2 2

Table 50: Preventive spare parts - Precharge PCB
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS546/10 VIS5000-08 4/10KVA
CS00234 rev.
1.0 (precharge board)

1597.00.540 1 1 1 1 1 1 1

Table 51: Preventive spare parts - Ethernet adapter
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EPS542 CRE/VIS
ethernet and single ethernet
adapter PCB
CS00230 rev.1.0

1597.00.600 1 1 1 1 1 1 1 1 1

EPS542 CRE/VIS ethernet and
double ethernet adapter PCB
CS00230 rev.1.0

1597.00.610 1 1 1 1 1 1 1 1 1
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Table 52: Preventive spare parts - Display and keyboard
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Description Part number

CCR KEYBOARD BOX
ASSY. TRIPHASE

4072.30.630 1 1 1 1 1 1 1 1 1

10.9 Corrective spare parts

Item Table

Manual switch Table 53

Main fuse housing Table 54

Line filter Table 55

Output Filter Table 56

Capacitors Table 57

Precharge resistors Table 58

Main transformer Table 59

Fan connector cable Table 60

Table 53: Corrective spare parts - Manual switch
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

S203-C10 6150.90.740 1

S203-C16 6150.90.540 1 1

S203-C20 6150.90.550 1

S203-C25 6150.90.570

S203-C40 6150.90.620 1 1

S203-C50 6150.90.590

S293-C80 6150.90.650 1 1

S293-C100 6150.90.660 1

Table 54: Corrective spare parts - Main fuse housing
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Fuse housing 32 6150.90.670 1 1 1 1

Fuse housing 50 6150.90.730 1 1

Fuse housing 125 6150.90.680 1 1 1
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Table 55: Corrective spare parts - Line filter
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

EMK3012 (3Ph 10 400V) 6115.18.100 1

EMK3020 (3Ph 20A
400V)

6115.18.110 1 1 1

EMK3040 3Ph 40A/400V
line filter

6115.18.080 1 1

EMK3050 6115.18.150

EMK3070 (3Ph 70A/400V
line filter

6115.18.160

EMK3100 (3 Ph 100A
400V)

6115.18.140 1 1 1

Toroidal inductor 13mH/
10A

6166.50.330 1

Toroidal inductor 16,5mH/
16A

6166.50.340 1 1

Toroidal inductor 10mH/
35A

6166.50.320 1

Inductance 10mH/40A code:1212 6166.50.300 1 1 2 2 2

Table 56: Corrective spare parts - Output filter
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Toroidal inductor 750uH/
15A

6166.50.350 2 2

Inductance 285uH/40A 6166.50.310 4 6 6 6 12 12 12

CAP. PMC1704500KVR
5uF/700V step 20-25+

6322.60.220 2 2 2 2 2

CAP.30uF 400V Ecofill
MLR25PRL 453004591

6322.60.300 1 1 2 2 2 3 6 8 8

Table 57: Corrective spare parts - Capacitors
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

CAP. AYUX-
HR472M400DF1 LBK-Int.
4700uF/400V M12

6322.60.200 2 2 2 4 4 6 8 8

CAP. AYUX-
HR222M400DC LBK Int.
2200uF/400V M12

6322.60.210 2 2

Table 58: Corrective spare parts - Precharge resistors
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Resistor 15K/10W a filo smaltata
EPS:529

6310.60.200 2 2 2 2 2 2 6 8 8
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Table 59: Corrective spare parts - Main transformer
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

Transf.400Vac out:24V ref:524108 6300.03.430 1 1 1 1 1 1 1 1 1

Transf.100VA 400V/24V-
94VA/24V-6VA

6300.03.400 1 1 1 1 1 1

Transf.200VA 400V/24V-
6VA/24V-194VA

6300.03.410 1 1 1

Table 60: Corrective spare parts - Fan connector cable
Description Part number Quantity per order

2.5 4 5 7.5 10 15 20 25 30

CCR FAN connect.cable
(15kVA )

6100.15.300 1
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Appendix A: SUPPORT

Our experienced engineers are available for support and service at all times, 24 hour/7 days a week. They are part of a
dynamic organization making sure the entire ADB SAFEGATE is committed to minimal disturbance for airport operations.

ADB SAFEGATE Support

Technical Support – Global
Customers in Europe, the Middle East, Africa or Asia Pacific are more than welcome to our portal
for technical support. Trained in all areas of system issues, troubleshooting, quality control and
technical assistance, our highly experienced Technical support specialists are available 24 hours a
day, seven days a week to provide assistance over the phone. In the Americas, we also offer live
technical support.
Live Technical Support – Americas
If at any time you have a question or concern about your product, contact ADB SAFEGATE’s
US-based technical support specialists, available 24 hours a day, seven days a week, to assist you
via phone.
ADB SAFEGATE Americas Technical Service & Support (US & Canada) :+1-800-545-4157
ADB SAFEGATE Americas Technical Service & Support (Canada): +1-905-631-1597
ADB SAFEGATE Americas Technical Service & Support (International): +1-614-861-1304

We can also be reached via email during regular business hours:
Airfield and Gate: techservice.us@adbsafegate.com
Gate: gateservice.us@adbsafegate.com

We look forward to working with you!

Before You Call
When you have an airfield lighting or system control system problem, prior to calling, please ensure
the following:

• Review the product's manual and troubleshooting guide.

• Be located with the product ready to troubleshoot.

• Have all necessary information available: airport code/company name, customer id number,
contact phone number/email address, product/part number.

• Have a True RMS meter available and any other necessary tools.

When calling about an issue with Safedock A-VDGS, we can serve you better if you collect the
following information before you call:

• Relevant information regarding the issue you are calling about, such as gate number, flight
number, aircraft type and time of the event.

• What, if any, actions have been taken to resolve the issue prior to the call.

• If available, provide a CCTV recording of the incident to aid in aligning the information from the
Safedock log file.

Note
For more information, see www.adbsafegate.com, contact ADB SAFEGATE Support via email at
support@adbsafegate.com or
Europe: +32 2 722 17 11
Americas: +1 614 861 1304. Press 3 for technical service or press 4 for sales support.
China: +86 (10) 8476 0106
Middle East and Africa: +971 4 452 7575

UM-6007, Rev. 2.2, 2024/07/17 137
Copyright © ADB Safegate, All Rights Reserved

http://www.adbsafegate.com


A.1 ADB SAFEGATE Website

The ADB SAFEGATE website, www.adbsafegate.com, offers information regarding our airport solutions, products, company,
news, links, downloads, references, contacts and more.

A.2 Recycling

A.2.1 ADB SAFEGATE Recycling
ADB SAFEGATE is fully committed to environmentally-conscious manufacturing with strict monitoring of our own processes as
well as supplier components and sub-contractor operations. ADB SAFEGATE offers a recycling program for our products to all
customers worldwide, whether or not the products were sold within the EU.

ADB SAFEGATE products and/or specific electrical and electronic component parts which are fully removed/separated from
any customer equipment and returned will be accepted for our recycling program.

All items returned must be clearly labeled as follows:

• For ROHS/WEEE Recycling

• Sender contact information (Name, Business Address, Phone number).

• Main Unit Serial Number.

ADB SAFEGATE will continue to monitor and update according for any future requirements for EU directives as and when EU
member states implement new regulations and or amendments. It is our aim to maintain our compliance plan and assist our
customers.

A.2.1.1 Local Authority Recycling
The disposal of ADB SAFEGATE products is to be made at an applicable collection point for the recycling of electrical and
electronic equipment. The correct disposal of equipment prevents any potential negative consequences for the environment
and human health, which could otherwise be caused by inappropriate waste handling. The recycling of materials helps to
conserve natural resources. For more detailed information about recycling of products, contact your local authority city office.
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